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Preface

This publication contains installation and configuration instructions for the IBM®
Tivoli® Storage Manager server, server languages, and other Tivoli Storage
Manager components.

Instructions for installing the Tivoli Storage Manager license, device driver, and
storage agent are in this publication.

Who should read this guide

This publication is intended for a system administrator installing and configuring a
Version 7.1 Tivoli Storage Manager server, the Operations Center, or upgrading
from Tivoli Storage Manager Version 6.

If you are upgrading an existing 5.5.x Tivoli Storage Manager server to Tivoli
Storage Manager Version 7.1, see the Upgrade and Migration Guide for V5 Servers.

If you are upgrading a Tivoli Storage Manager Version 6.1, Version 6.2, or Version
6.3 server to a newer version, see |Chapter 5, “Upgrading to Tivoli Storage Manager]|
[Version 7.1,” on page 67

If you are upgrading an existing Tivoli Storage Manager Version 7.1 server to a
later level of Version 7.1, see [Chapter 4, “Installing a Tivoli Storage Manager server|
ffix pack,” on page 63

Installable components

The IBM Tivoli Storage Manager server and licenses are required components.

You can install the following components for Tivoli Storage Manager V7.1.0 or
later.

¢ Tivoli Storage Manager server

* Tivoli Storage Manager server languages
* Tivoli Storage Manager licenses

* Tivoli Storage Manager devices

* Tivoli Storage Manager storage agent

describes all the installable components.

Table 1. Tivoli Storage Manager installable components

Tivoli Storage Description Additional information
Manager component
Server (required) Includes the database, See the Tivoli Storage Manager server overview in the

GSKit, and tools to help Administrator’s Guide.
you configure and manage
Tivoli Storage Manager.

Language package
(optional)

Each language package See [“Installing server language packages” on page 36.
(one for each language)

contains language-specific
information for the server.

© Copyright IBM Corp. 1993, 2013 \%



Table 1. Tivoli Storage Manager installable components (continued)

Tivoli Storage
Manager component

Description

Additional information

Licenses (required)

Includes support for all
Tivoli Storage Manager
licensed features. After you
install this package, you
must configure the licenses
you purchased.

See the chapter on managing server operations in the
Administrator’s Guide.

Devices (optional)

Extends Tivoli Storage
Manager media
management capability.

See the chapter on adding devices in the Administrator’s Guide.

A list of devices that are supported by this driver is available
from the Tivoli Storage Manager website, at

http:/ /www.ibm.com /support/entry /portal /Overview /|

Software/Tivoli/Tivoli_Storage Manager|

Storage agent
(optional)

Installs the component that
allows client systems to
write data directly to, or
read data directly from,
storage devices that are
attached to a storage area
network (SAN).
Remember: The IBM
Tivoli Storage Manager for
Storage Area Networks is a
separately licensed
product.

See the Storage Agent User's Guide.

vi IBM Tivoli Storage Manager for Oracle Solaris: Installation Guide
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New for Tivoli Storage Manager Version 7.1

Many features in IBM Tivoli Storage Manager V7.1 are new for Tivoli Storage
Manager users. These changes affect the Tivoli Storage Manager server, the
Operations Center, the Administration Center, Tivoli Monitoring for Tivoli Storage
Manager, and the upgrade to V7.1.

These installation-related features are new for Tivoli Storage Manager in V7.1. For
a complete list of new V7.1 features, see the "What’s new in the products" topic in
the Tivoli Storage Manager information center at fhttp://pic.dhe.ibm.com /|

|infocenter /tsminfo/ V7r1|.

DB2°® Version 10.5 database implementation

Tivoli Storage Manager V7.1 is installed with the latest version of the IBM
DB2 database software, V10.5. The DB2 technology provides management
functions for the server database.

The previous Tivoli Storage Manager server release, V6.3, was packaged
with a DB2 V9.7 database.

If you are upgrading the server, you must ensure that the correct version
of DB2 is installed. If you are using a Tivoli Storage Manager V6.1 server,
and you want to upgrade to V7.1, you must upgrade the V6.1 server to
V6.2 or V6.3. Then, upgrade the server from V6.2 or V6.3 to V7.1. The
Tivoli Storage Manager V6.1 server was packaged with a DB2 V9.5
database, which cannot be upgraded to V10.5. The Tivoli Storage Manager
V6.2 and V6.3 servers were packaged with a DB2 V9.7 database, which can
be upgraded to V10.5.

IBM Installation Manager

In Tivoli Storage Manager V7.1, the server uses IBM Installation Manager
to install or update software. If the required version of IBM Installation
Manager is not already installed, it is automatically installed or upgraded
when you install the Tivoli Storage Manager server. It must remain
installed on the system so that the server can be updated or uninstalled
later as needed.

Operations Center updates

© Copyright IBM Corp. 1993, 2013

The IBM Tivoli Storage Manager Operations Center is a web-based
interface for managing your storage environment.

Restriction: The Operations Center cannot be installed on HP-UX or
Oracle Solaris systems. However, you can use the Operations Center to
manage Tivoli Storage Manager V6.3.4 or later servers that run on HP-UX
or Oracle Solaris systems.

You can now do the following additional administrative tasks through the
Operations Center:

* Customize the settings for servers and clients by editing the server and
client properties.

* View or cancel the sessions and processes that are in progress by using
the Active Tasks view for servers.

* View the sessions and processes that succeeded or failed by using the
Completed Tasks view for servers.

vii
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* View activity log messages that are related to specific alerts, sessions,
and processes. These activity log messages are available on the Alerts
page and in the Active Tasks and Completed Tasks views.

* Manually back up clients, storage pools, and the server database.
* View the replication server configuration for a client.

* Register clients, and configure basic backup settings.

* Suppress risk warnings for specific clients.

* View the authority level of the administrator ID that is used to log in to
the Operations Center.

Administration Center availability
Although the Tivoli Storage Manager Administration Center is not
delivered with V7.1 or later versions, you can instead use the Operations
Center, which is a web-based interface for managing your storage
environment.

You can use the V6.3.4 Administration Center with any Tivoli Storage
Manager V6.3 or later server, including to automatically update
backup-archive clients. For more information about the Tivoli Storage
Manager Administration Center, see the Tivoli Storage Manager V6.3
Information Center at: http:/ /pic.dhe.ibm.com/infocenter/ tsminfo/v6r3 /|

ndex.jspl
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Part 1. Installing and upgrading the server

Install and upgrade the Tivoli Storage Manager server.

Before you begin

Planning to install H Installing components H Taking the first steps

Figure 1. As highlighted in the figure, you are in the planning to install the Tivoli Storage Manager server section.
Review this section carefully to ensure that you have the system and other requirements needed to install Tivoli
Storage Manager.

© Copyright IBM Corp. 1993, 2013
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Chapter 1. Planning to install the Tivoli Storage Manager
server

Install the Tivoli Storage Manager server software on the computer that manages
storage devices and install the Tivoli Storage Manager client software on every
workstation that transfers data to Tivoli Storage Manager server-managed storage.

About this task

Tivoli Storage Manager server maintenance releases, client software, and
publications are available from the Tivoli Storage Manager website at
http:/ /www.ibm.com /support/entry /portal /Overview /Software / Tivoli /|
Tivoli_Storage Manager|

Allow approximately 30 - 45 minutes to install a Tivoli Storage Manager Version
7.1 server, using this guide.

An upgrade from V6.1.x, V6.2.x, or V6.3.x to V7.1 takes approximately 20 - 50
minutes. Your environment might produce different results than that obtained in
the labs.

The following figure illustrates the main parts for installing a new Tivoli Storage
Manager server.

Configure and start the
server, register licenses,
prepare for backups

Select a method to First

Preview and verify
install the software steps

server requirements

What you should know first

Before installing IBM Tivoli Storage Manager, be familiar with your operating
systems, storage devices, communication protocols, and system configurations.

Table 2. Upgrade information

To upgrade from this
version To this version See this information

V7.1 V7.1 fix pack or interim fix Chapter 4, “Installing a Tivoli|

Storage Manager server fix
back,” on page 63|

V6.2 or V6.3 V7.1 “Upgrading from Tivoli]
Storage Manager V6.2 or
V6.3 to V7.1” on page 68

V6.1 V7.1 “Upgrading from Tivoli
Storage Manager V6.1 to|
V7.1” on page 76|

© Copyright IBM Corp. 1993, 2013
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Installing the Tivoli Storage Manager server

Table 2. Upgrade information (continued)

To upgrade from this
version To this version See this information

V5.5 V7.1 Upgrade and Migration Guide
for V5 Servers

If you are migrating a Tivoli Storage Manager server, see the following
documentation:

« V5 server on an AIX®, HP-UX, or Solaris operating system to V6.3.4 or later on a
Linux x86_64 operating system, see the Upgrade and Migration Guide for V5
Servers.

Restriction: You can install and run the Version 7.1 server on a system that already
has DB2 installed on it, whether DB2 was installed independently or as part of
some other application, with some restrictions. For details, see [“Compatibility of]
the Tivoli Storage Manager server with other DB2 products on the system” on|

page 6.|

Experienced DB2 administrators can choose to perform advanced SQL queries and
use DB2 tools to monitor the database. Do not, however, use DB2 tools to change
DB2 configuration settings from those that are preset by Tivoli Storage Manager, or
alter the DB2 environment for Tivoli Storage Manager in other ways, such as with
other products. The Tivoli Storage Manager Version 7.1 server has been built and
tested extensively using the data definition language (DDL) and database
configuration that Tivoli Storage Manager deploys.

Attention: Do not alter the DB2 software that is installed with Tivoli Storage
Manager installation packages and fix packs. Do not install or upgrade to a
different version, release, or fix pack of DB2 software because doing so can damage
the database.

System requirements for the Tivoli Storage Manager server

4

The Tivoli Storage Manager server can require a large amount of memory, network
bandwidth, and processor resources. In many cases, the server performs best when
other applications are not installed on the same system.

Hardware requirements

These tables list the minimum hardware and software requirements for the
installation of a Tivoli Storage Manager server. Use these requirements as a starting
point. You can find the most current information about system requirements at
[Tivoli Storage Manager Supported Operating Systems|

See Tivoli Storage Manager Optimizing Performance for server configuration
guidelines and best practices.

[Table 3 on page 5| describes the minimum hardware requirements that are needed
for your Tivoli Storage Manager Solaris system. For more details about planning
disk space, see|‘Capacity planning” on page 9

IBM Tivoli Storage Manager for Oracle Solaris: Installation Guide
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Installing the Tivoli Storage Manager server

Table 3. Hardware requirements

Type of

hardware Hardware requirements

Hardware One of the following processors is required:

* Ultra SPARC-based processors (sun4u architecture)
+ Ultra SPARC-based processors (sun4v architecture)

Disk space The following list is the minimum values for disk space for Ultra
SPARC-based processors (sun4u and sun4v architecture) for the respective
directories and logs:

* 512 MB for the /var directory
* 4 GB for the installation directory
* 2 GB for the /tmp directory
* 300 MB for the /usr directory
* 2 GB in the home directory

Tip: Expect to use more space for problem determination.
* 2 GB for the shared resources area
Significant additional disk space is required for database and log files. The
size of the database depends on the number of client files to be stored and
the method by which the server manages them. The default active log
space is 16 GB, the minimum that is needed for most workloads and
configurations. Allocate at least three times the active log space for the
archive log (48 GB). Ensure that you have sufficient resources if you are
using data deduplication or expect a heavy client workload.
For optimal performance and to facilitate I/O, specify at least two equally
sized containers or Logical Unit Numbers (LUNs) for the database. See
Optimizing Performance for more information about the configuration of
directories for the database. In addition, each active log and archive log
should have its own container or LUN.
Ensure that you see the capacity planning section for more details about
disk space.

Memory The following minimum values for memory:

* 12 GB.
* 16 GB if you are using data deduplication.

* At least 32 GB for heavily used servers. Using 32 GB or more of memory
enhances performance of the Tivoli Storage Manager server database
inventory.

* If you plan to run multiple instances, each instance requires the memory
listed for one server. Multiply the memory for one server by the number
of instances planned for the system.

* Node replication processing requires additional memory. Use a minimum
of 32 GB of memory for node replication without data deduplication.
Node replication with data deduplication requires a minimum of 64 GB
of memory.

* When you create the active log, you need at least 64 GB of memory to
run replication. If replication and deduplication are both being used,
create an active log of 128 GB in size.

Tip: Ensure that there is at least twice as much swap space allocated as
there is physical memory on the system.

Chapter 1. Planning to install the IBM Tivoli Storage Manager server 5



Installing the Tivoli Storage Manager server

Software requirements

describes the minimum software requirements that are needed for your
Tivoli Storage Manager Solaris system.

Table 4. Software requirements

Type of
software

Minimum software requirements

Operating
system

Oracle Solaris 10 Update 10 on SPARC, running in 64-bit kernel system
with sun4u or sun4v architecture

* Patch 118822-25
* If raw devices are used, patch 125100-07

Communication
protocol

TCP/1P

Device drivers

The Tivoli Storage Manager device driver required for non-IBM drives
and tape libraries. The Tivoli Storage Manager device driver package
contains device driver tools and ACSLS daemons.

For the IBM 3590, 3592, or the Ultrium tape library or drives, the IBM
device drivers are required. Install the most current device drivers. You
can locate IBM driver packages at the Fix Central website:

Ihttp:/ /www.ibm.com/support/ fixcentral /|

Configure the device drivers before you use the Tivoli Storage Manager
server with tape devices.

Gunzip utility

The gunzip utility must be available on your system before you install or
upgrade the Tivoli Storage Manager Version 7 server. Ensure that the
gunzip utility is installed and the path to it is set in the PATH
environment variable.

Other software

Korn Shell (ksh)

Compatibility of the Tivoli Storage Manager server with other DB2

products on the system

You can install other products that deploy and use DB2 products on the same
system as the Tivoli Storage Manager Version 7.1 server on AIX, HP-UX, Linux,
and Oracle Solaris platforms, with some limitations.

To install and use other products that use a DB2 product on the same system as
the Tivoli Storage Manager server, ensure that the following criteria are met:

Table 5. Compatibility of the Tivoli Storage Manager server with other DB2 products on the

system

Criterion

Instructions

Version level

The other products that use a DB2 product
must use DB2 version 9 or later. DB2
products include product encapsulation and
segregation support beginning with Version
9. Starting with this version, you can run
multiple copies of DB2 products, at different
code levels, on the same system. For details,
see the information about multiple DB2
copies: [http: / /pic.dhe.ibm.com /infocenter /|

db2luw /v10r.

6 IBM Tivoli Storage Manager for Oracle Solaris: Installation Guide
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Installing the Tivoli Storage Manager server

Table 5. Compatibility of the Tivoli Storage Manager server with other DB2 products on the

system (continued)

Criterion

Instructions

User IDs and directories

Ensure that the user IDs, fence user IDs,
installation location, other directories, and
related information are not shared across
DB2 installations. Your specifications must
be different from the IDs and locations that
you used for the Tivoli Storage Manager
server installation and configuration. If you
used the dsmicfgx wizard or dsmupgdx
wizard to configure Version 7.1, or upgrade
the server from Version 5.5, these are values
that you entered when running the wizard.
If you used the manual configuration for
Version 7.1 or upgrade from Version 5.5
procedures, review the procedures that you
used if necessary to recall the values that
were used for the server.

Resource allocation

Consider the resources and capability of the
system compared to the requirements for
both the Tivoli Storage Manager server and
the other applications that use the DB2
product. To provide sufficient resources for
the other DB2 applications, you might have
to change the Tivoli Storage Manager server
settings so that the server uses less system
memory and resources. Similarly, if the
workloads for the other DB2 applications
compete with the Tivoli Storage Manager
server for processor or memory resources,
the performance of the server in handling
the expected client workload or other server
operations might be adversely affected.

To segregate resources and provide more
capability for the tuning and allocation of
processor, memory, and other system
resources for multiple applications, consider
using logical partition (LPAR), workload
partition (WPAR), or other virtual
workstation support. For example, run a
DB2 application on its own virtualized
system.

IBM Installation Manager

Tivoli Storage Manager uses IBM Installation Manager, which is an installation
program that can use remote or local software repositories to install or update

many IBM products.

If the required version of IBM Installation Manager is not already installed, it is
automatically installed or upgraded when you install Tivoli Storage Manager. It
must remain installed on the system so that Tivoli Storage Manager can be

updated or uninstalled later as needed.

Chapter 1. Planning to install the IBM Tivoli Storage Manager server 7
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Storage Manager server

The following list contains explanations of some terms that are used in IBM
Installation Manager:

Offering
An installable unit of a software product.

The Tivoli Storage Manager offering contains all of the media that IBM
Installation Manager requires to install Tivoli Storage Manager.

Package
The group of software components that are required to install an offering.
The Tivoli Storage Manager package contains the following components:
 IBM Installation Manager installation program
¢ Tivoli Storage Manager offering

Package group
A set of packages that share a common parent directory.

The default package group for the Tivoli Storage Manager package is IBM
Tivoli Storage Manager.

Repository
A remote or local storage area for data and other application resources.

The Tivoli Storage Manager package is stored in a repository on IBM Fix
Central.

Shared resources directory
A directory that contains software files or plug-ins that are shared by
packages.

IBM Installation Manager stores installation-related files in the shared
resources directory, including files that are used for rolling back to a
previous version of Tivoli Storage Manager.

Worksheets for planning details for the Tivoli Storage Manager server

You can use the worksheets to help you plan the amount and location of storage
needed for the Tivoli Storage Manager server. You can also use them to keep track
of names and user IDs.

See Tivoli Storage Manager Optimizing Performance for server configuration
guidelines and best practices.

Item

Space required Number of directories Location of directories

The database

Active log

Archive log

Optional: Log mirror for
the active log

Optional: Secondary
archive log (failover
location for archive log)

8
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Item

Names and user IDs

Location

The instance user ID for the
server, which is the ID you use
to start and run the Tivoli
Storage Manager server

The home directory for the server,
which is the directory that
contains the instance user ID

The database instance name

The instance directory for the
server, which is a directory that
contains files specifically for this
server instance (the server
options file and other
server-specific files)

Server name, use a unique name
for each server

Capacity planning

Capacity planning for Tivoli Storage Manager includes managing resources such as
the database and recovery log. To maximize resources as part of capacity planning,
you must estimate space requirements for the database and the recovery log.

Procedure

For information about the benefits of deduplication and guidance on how to make
effective use of the Tivoli Storage Manager deduplication feature, see Optimizing
Performance.

Estimating space requirements for the database

To estimate space requirements for the database, you can use the maximum
number of files that can be in server storage at one time or you can use storage
pool capacity.

About this task

Consider using at least 25 GB for the initial database space. Provision file system
space appropriately. A database size of 25 GB is adequate for a test environment or
a library-manager-only environment. For a production server supporting client
workloads, the database size is expected to be larger. If you use random-access
disk (DISK) storage pools, more database and log storage space is needed than for
sequential-access storage pools.

The maximum size of the Tivoli Storage Manager database is 4 TB.

For information about sizing the database in a production environment that is
based on the number of files and on storage pool size, see the following topics.

Chapter 1. Planning to install the IBM Tivoli Storage Manager server 9
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10

Estimating database space requirements based on the number of
files

If you can estimate the maximum number of files that might be in server storage at
a time, you can use that number to estimate space requirements for the database.

About this task

To estimate space requirements that is based on the maximum number of files in
server storage, use the following guidelines:

* 600 - 1000 bytes for each stored version of a file, including image backups.

Restriction: The guideline does not include space that is used during data
deduplication.

* 100 - 200 bytes for each cached file, copy storage pool file, active-data pool file,
and deduplicated file.

* Additional space is required for database optimization to support varying
data-access patterns and to support server back-end processing of the data. The
amount of extra space is equal to 50% of the estimate for the total number of
bytes for file objects.

In the following example for a single client, the calculations are based on the
maximum values in the preceding guidelines. The examples do not take into
account that you might use file aggregation. In general, when you aggregate small
files, it reduces the amount of required database space. File aggregation does not
affect space-managed files.

Procedure
1. Calculate the number of file versions. Add each of the following values to
obtain the number of file versions:

a. Calculate the number of backed-up files. For example, as many as 500,000
client files might be backed up at a time. In this example, storage policies
are set to keep up to three copies of backed up files:

500,000 files * 3 copies = 1,500,000 files

b. Calculate the number of archive files. For example, as many as 100,000
client files might be archived copies.

c. Calculate the number of space-managed files. For example, as many as
200,000 client files might be migrated from client workstations.

Using 1000 bytes per file, the total amount of database space that is required

for the files that belong to the client is 1.8 GB:

(1,500,000 + 100,000 + 200,000) * 1000 = 1.8 GB

2. Calculate the number of cached files, copy storage-pool files, active-data pool
files, and deduplicated files:

a. Calculate the number of cached copies. For example, caching is enabled in a
5 GB disk storage pool. The high migration threshold of the pool is 90%
and the low migration threshold of the pool is 70%. Thus, 20% of the disk
pool, or 1 GB, is occupied by cached files.

If the average file size is about 10 KB, approximately 100,000 files are in
cache at any one time:
100,000 files * 200 bytes = 19 MB

b. Calculate the number of copy storage-pool files. All primary storage pools
are backed up to the copy storage pool:

(1,500,000 + 100,000 + 200,000) * 200 bytes = 343 MB
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c. Calculate the number of active storage-pool files. All the active
client-backup data in primary storage pools is copied to the active-data
storage pool. Assume that 500,000 versions of the 1,500,000 backup files in
the primary storage pool are active:

500,000 * 200 bytes = 95 MB

d. Calculate the number of deduplicated files. Assume that a deduplicated
storage pool contains 50,000 files:

50,000 * 200 bytes = 10 MB

Based on the preceding calculations, about 0.5 GB of extra database space is
required for the client’s cached files, copy storage-pool files, active-data pool
files, and deduplicated files.

3. Calculate the amount of extra space that is required for database optimization.
To provide optimal data access and management by the server, extra database
space is required. The amount of extra database space is equal to 50% of the
total space requirements for file objects.

(1.8 + 0.5) * 50% = 1.2 GB

4. Calculate the total amount of database space that is required for the client. The
total is approximately 3.5 GB:

1.8 +0.5+1.2=3.5GB

5. Calculate the total amount of database space that is required for all clients. If
the client that was used in the preceding calculations is typical and you have
500 clients, for example, you can use the following calculation to estimate the
total amount of database space that is required for all clients:

500 * 3.5 = 1.7 TB
Results

Tip: In the preceding examples, the results are estimates. The actual size of the
database might differ from the estimate because of factors such as the number of
directories and the length of the path and file names. Periodically monitor your
database and adjust its size as necessary.

What to do next

During normal operations, the Tivoli Storage Manager server might require
temporary database space. This space is needed for the following reasons:

¢ To hold the results of sorting or ordering that are not already being kept and
optimized in the database directly. The results are temporarily held in the
database for processing.

* To give administrative access to the database through one of the following
methods:

- A DB2 open database connectivity (ODBC) client
— An Oracle Java™ database connectivity (JDBC) client

— Structured Query Language (SQL) to the server from an administrative-client
command line

Consider using an extra 50 GB of temporary space for every 500 GB of space for
file objects and optimization. See the guidelines in the following table. In the
example that is used in the preceding step, a total of 1.7 TB of database space is
required for file objects and optimization for 500 clients. Based on that calculation,
200 GB is required for temporary space. The total amount of required database
space is 1.9 TB.
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12

Database size Minimum temporary-space requirement
< 500 GB 50 GB
2500 GBand <1 TB 100 GB
z1TBand <15 TB 150 GB
z15and <2 TB 200 GB
z2and <3 TB 250 - 300 GB
z3and <4 TB 350 - 400 GB

Estimating database space requirements based on storage pool
capacity

To estimate database space requirements based on storage pool capacity, use a ratio
of 1 - 5%. For example, if you require 200 TB of storage pool capacity, the size of
your database is expected to be 2 - 10 TB. As a general rule, make your database
as large as possible to prevent running out of space. If you run out of database
space, server operations and client-store operations can fail.

The database manager and temporary space

The Tivoli Storage Manager server database manager manages and allocates
system memory and disk space for the database. The amount of database space
you require depends on the amount of system memory available and the server
workload.

The database manager sorts data in a specific sequence, as per the SQL statement
that you issue to request the data. Depending on the workload on the server, and
if there is more data than the database manager can manage, the data (that is
ordered in sequence) is allocated to temporary disk space. Data is allocated to
temporary disk space when there is a large result set. The database manager
dynamically manages the memory used when data is allocated to temporary disk
space.

For example, expiration processing can produce a large result set. If there is not
enough system memory on the database to store the result set, some of the data is
allocated to temporary disk space. During expiration processing, if a node or file
space are selected that are too large to process, the database manager does not
have enough memory to sort the data.

To run database operations, consider adding more database space for the following

scenarios:

e The database has a small amount of space and the server operation that requires
temporary space uses the remaining free space.

¢ The file spaces are large, or the file spaces has a policy assigned to it which
creates many file versions.

* The Tivoli Storage Manager server must run with limited memory. The database
uses the Tivoli Storage Manager server main memory to run database
operations. However, if there is insufficient memory available, the Tivoli Storage
Manager server allocates temporary space on disk to the database. For example,
if 10G of memory is available and database operations require 12G of memory,
the database uses temporary space.

* An out of database space error is displayed when you deploy a Tivoli Storage
Manager V6 server. Monitor the server activity log for messages related to
database space.
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Important: Do not change the DB2 software that is installed with the Tivoli
Storage Manager installation packages and fix packs. Do not install or upgrade to a
different version, release, or fix pack, of DB2 software to avoid damage to the
database.

Recovery log space requirements

In Tivoli Storage Manager, the term recovery log comprises the active log, the
archive log, the active log mirror, and the archive failover log. The amount of space
that you require for the recovery log depends on various factors, including, for
example, the amount of client activity with the server.

Active and archive log space
When you estimate space requirements for active and archive logs, include some
extra space for contingencies such as occasional heavy workloads and failovers.

In Tivoli Storage Manager servers V6.1 and later, the active log can be a maximum
size of 128 GB. The archive log size is limited to the size of the file system that it is
installed on.

Use the following general guidelines when you estimate the size of the active log:
* The suggested starting size for the active log is 16 GB.

* Ensure that the active log is at least large enough for the amount of concurrent
activity that the server typically handles. As a precaution, try to anticipate the
largest amount of work that the server manages at one time. Provision the active
log with extra space that can be used if needed. Consider using 20% of extra
space.

* Monitor used and available active log space. Adjust the size of the active log as
needed, depending upon factors such as client activity and the level of server
operations.

* Ensure that the directory that holds the active log is as large as, or larger than,
the size of the active log. A directory that is larger than the active log can
accommodate failovers, if they occur.

* Ensure that the file system that contains the active log directory has at least 8
GB of free space for temporary log movement requirements.

The suggested starting size for the archive log is 48 GB.

The archive log directory must be large enough to contain the log files that are
generated since the previous full backup. For example, if you perform a full
backup of the database every day, the archive log directory must be large enough
to hold the log files for all the client activity that occurs during 24 hours. To
recover space, the server deletes obsolete archive log files after a full backup of the
database. If the archive log directory becomes full and a directory for archive
failover logs does not exist, log files remain in the active log directory. This
condition can cause the active log directory to fill up and stop the server. When the
server restarts, some of the existing active-log space is released.

After the server is installed, you can monitor archive log utilization and the space
in the archive log directory. If the space in the archive log directory fills up, it can
cause the following problems:

* The server is unable to perform full database backups. Investigate and resolve
this problem.

* Other applications write to the archive log directory, exhausting the space that is
required by the archive log. Do not share archive log space with other
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applications including other Tivoli Storage Manager servers. Ensure that each
server has a separate storage location that is owned and managed by that
specific server.

For guidance about the layout and tuning of the active log and archive log, see
Optimizing Performance.

Example: Estimating active and archive log sizes for basic client-store
operations:

Basic client-store operations include backup, archive, and space management. Log
space must be sufficient to handle all store transactions that are in progress at one
time.

To determine the sizes of the active and archive logs for basic client-store
operations, use the following calculation:

number of clients x files stored during each transaction
x Tlog space needed for each file

This calculation is used in the example in the following table.

Table 6. Basic client-store operations

Item

Example
values Description

Maximum number of client nodes 300 The number of client nodes that back up, archive, or migrate
that back up, archive, or migrate files files every night.
concurrently at any time

Files stored during each transaction |4096 The default value of the server option TXNGROUPMAX is 4096.

file

Log space that is required for each | 3053 bytes The value of 3053 bytes for each file in a transaction

represents the log bytes that are needed when backing up
files from a Windows client where the file names are 12 -
120 bytes.

This value is based on the results of tests performed under
laboratory conditions. The tests consisted of backup-archive
clients performing backup operations to a random-access
disk (DISK) storage pool. DISK pools result in more log use
than sequential-access storage pools. Consider a value larger
than 3053 bytes if the data being stored has file names that
are longer than 12 - 120 bytes.

Active log: Suggested size 19.5 GB! Use the following calculation to determine the size of the

active log. One GB equals 1,073,741,824 bytes.

(300 clients x 4096 files stored during each
transaction x 3053 bytes for each file) + 1,073,741,824
bytes = 3.5 GB

Increase that amount by the suggested starting size of 16
GB:

3.5+ 16 = 19.5 GB

14
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Table 6. Basic client-store operations (continued)

Example
Item values Description
Archive log: Suggested size 58.5 GB ! Because of the requirement to be able to store archive logs

across three server database-backup cycles, multiply the
estimate for the active log by 3 to estimate the total archive
log requirement.

3.5 x 3 =10.5GB

Increase that amount by the suggested starting size of 48
GB:

10.5 + 48 = 58.5 GB

! The example values in this table are used only to illustrate how the sizes for active logs and archive logs are
calculated. In a production environment that does not use deduplication, 16 GB is the suggested minimum size for
an active log. The suggested minimum size for an archive log in a production environment that does not use
deduplication is 48 GB. If you substitute values from your environment and the results are larger than 16 GB and 48
GB, use your results to size the active log and archive log.

Monitor your logs and adjust their size if necessary.

Example: Estimating active and archive log sizes for clients that use multiple
sessions:

If the client option RESOURCEUTILIZATION is set to a value that is greater than the
default, the concurrent workload for the server increases.

To determine the sizes of the active and archive logs when clients use multiple
sessions, use the following calculation:

number of clients x sessions for each client x files stored
during each transaction x 1log space needed for each file

This calculation is used in the example in the following table.

Table 7. Multiple client sessions

Item Example values Description

Maximum number of client |300 1000 The number of client nodes that back up, archive, or

nodes that back up, archive, migrate files every night.

or migrate files concurrently

at any time

Possible sessions for each 3 3 The setting of the client option RESOURCEUTILIZATION is

client larger than the default. Each client session runs a maximum
of three sessions in parallel.

Files stored during each 4096 4096 The default value of the server option TXNGROUPMAX is 4096.

transaction
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Table 7. Multiple client sessions (continued)

Item Example values Description
Log space that is required for | 3053 3053 The value of 3053 bytes for each file in a transaction
each file represents the log bytes needed when backing up files from

a Windows client where the file names are 12 - 120 bytes.

This value is based on the results of tests performed under
laboratory conditions. Tests consisted of clients performing
backup operations to a random-access disk (DISK) storage
pool. DISK pools result in more log use than
sequential-access storage pools. Consider a value larger
than 3053 bytes if the data being stored has file names that
are longer than 12 - 120 bytes.

Active log: Suggested size 26.5 GB! 51 GB' The following calculation was used for 300 clients. One GB
equals 1,073,741,824 bytes.

(300 clients x 3 sessions for each client x 4096 files
stored during each transaction x 3053 bytes for each
file) + 1,073,741,824 = 10.5 GB

Increase that amount by the suggested starting size of 16
GB:

10.5 + 16 = 26.5 GB

The following calculation was used for 1000 clients. One
GB equals 1,073,741,824 bytes.

(1000 clients x 3 sessions for each client x 4096
files store during each transaction x 3053 bytes for
each file) + 1,073,741,824 = 35 GB

Increase that amount by the suggested starting size of 16
GB:

35+ 16 = 51 GB

Archive log: Suggested size |79.5GB' |153 GB' Because of the requirement to be able to store archive logs
across three server-database backup cycles, the estimate for
the active log is multiplied by 3:

10.5 x 3 = 31.5 GB
35 x 3 =105 GB

Increase those amounts by the suggested starting size of 48
GB:

31.5 + 48 = 79.5 GB

105 + 48 = 153 GB

! The example values in this table are used only to illustrate how the sizes for active logs and archive logs are
calculated. In a production environment that does not use deduplication, 16 GB is the suggested minimum size for
an active log. The suggested minimum size for an archive log in a production environment that does not use
deduplication is 48 GB. If you substitute values from your environment and the results are larger than 16 GB and 48
GB, use your results to size the active log and archive log.

Monitor your active log and adjust its size if necessary.
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Example: Estimating active and archive log sizes for simultaneous write
operations:

If client backup operations use storage pools that are configured for simultaneous
write, the amount of log space that is required for each file increases.

The log space that is required for each file increases by about 200 bytes for each
copy storage pool that is used for a simultaneous write operation. In the example
in the following table, data is stored to two copy storage pools in addition to a
primary storage pool. The estimated log size increases by 400 bytes for each file. If
you use the suggested value of 3053 bytes of log space for each file, the total
number of required bytes is 3453.

This calculation is used in the example in the following table.

Table 8. Simultaneous write operations

Item

Example
values Description

Maximum number of client nodes 300 The number of client nodes that back up, archive, or migrate
that back up, archive, or migrate files files every night.
concurrently at any time

Files stored during each transaction |4096 The default value of the server option TXNGROUPMAX is 4096.

Log space that is required for each | 3453 bytes 3053 bytes plus 200 bytes for each copy storage pool.

file

The value of 3053 bytes for each file in a transaction
represents the log bytes that are needed when backing up
files from a Windows client where the file names are 12 - 120
bytes.

This value is based on the results of tests performed under
laboratory conditions. The tests consisted of backup-archive
clients performing backup operations to a random-access
disk (DISK) storage pool. DISK pools result in more log use
than sequential-access storage pools. Consider a value larger
than 3053 bytes if the data being stored has file names that
are longer than 12 - 120 bytes.

Active log: Suggested size 20 GB ' Use the following calculation to determine the size of the

active log. One GB equals 1,073,741,824 bytes.

(300 clients x 4096 files stored during each
transaction x 3453 bytes for each file) + 1,073,741,824
bytes = 4.0 GB

Increase that amount by the suggested starting size of 16 GB:

4 + 16 = 20 GB

Archive log: Suggested size 60 GB ' Because of the requirement to be able to store archive logs

across three server database-backup cycles, multiply the
estimate for the active log by 3 to estimate the archive log
requirement:

4GB x 3 =12GB

Increase that amount by the suggested starting size of 48 GB:

12 + 48 = 60 GB

Chapter 1. Planning to install the IBM Tivoli Storage Manager server 17



Installing the Tivoli Storage Manager server

Table 8. Simultaneous write operations (continued)

Item

Example
values Description

! The example values in this table are used only to illustrate how the sizes for active logs and archive logs are
calculated. In a production environment that does not use deduplication, 16 GB is the suggested minimum size for
an active log. The suggested minimum size for an archive log in a production environment that does not use
deduplication is 48 GB. If you substitute values from your environment and the results are larger than 16 GB and 48
GB, use your results to size the active log and archive log.

Monitor your logs and adjust their size if necessary.

18

Example: Estimating active and archive log sizes for basic client store operations
and server operations:

Migration of data in server storage, identification processes for data deduplication,
reclamation, and expiration might run concurrently with client store operations.
Administrative tasks such as administrative commands or SQL queries from
administrative clients can also run concurrently with client store operations. Server
operations and administrative tasks that run concurrently can increase the active
log space that is required.

For example, migration of files from the random-access (DISK) storage pool to a
sequential-access disk (FILE) storage pool uses approximately 110 bytes of log
space for each file that is migrated. For example, suppose that you have 300
backup-archive clients and each one of them backs up 100,000 files every night.
The files are initially stored on DISK and then migrated to a FILE storage pool. To
estimate the amount of active log space that is required for the data migration, use
the following calculation. The number of clients in the calculation represents the
maximum number of client nodes that back up, archive, or migrate files
concurrently at any time.

300 clients x 100,000 files for each client x 110 bytes = 3.1 GB

Add this value to the estimate for the size of the active log that calculated for basic
client store operations.

Example: Estimating active and archive log sizes under conditions of extreme
variation:

Problems with running out of active log space can occur if you have many
transactions that complete quickly and some transactions that take much longer to
complete. A typical case occurs when many workstation or file-server backup
sessions are active and a few very large database server-backup sessions are active.
If this situation applies to your environment, you might need to increase the size
of the active log so that the work completes successfully.
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Example: Estimating archive log sizes with full database backups:

The Tivoli Storage Manager server deletes unnecessary files from the archive log
only when a full database backup occurs. Consequently, when you estimate the
space that is required for the archive log, you must also consider the frequency of
full database backups.

For example, if a full database backup occurs once a week, the archive log space
must be able to contain the information in the archive log for a full week.

The difference in archive log size for daily and full database backups is shown in
the example in the following table.

Table 9. Full database backups

Item

Example
values

Description

Maximum number of client nodes
that back up, archive, or migrate files
concurrently at any time

300

The number of client nodes that back up, archive, or migrate
files every night.

Files stored during each transaction

4096

The default value of the server option TXNGROUPMAX is 4096.

Log space that is required for each
file

3453 bytes

3053 bytes for each file plus 200 bytes for each copy storage
pool.

The value of 3053 bytes for each file in a transaction
represents the log bytes needed when backing up files from
a Windows client where the file names are 12 - 120 bytes.

This value is based on the results of tests performed under
laboratory conditions. Tests consisted of clients performing
backup operations to a random-access disk (DISK) storage
pool. DISK pools result in more log use than
sequential-access storage pools. Consider a value larger than
3053 bytes if the data being stored has file names that are
longer than 12 - 120 bytes.

Active log: Suggested size

20 GB!

Use the following calculation to determine the size of the
active log. One GB equals 1,073,741,824 bytes.

(300 clients x 4096 files per transaction x 3453 bytes
per file) + 1,073,741,824 bytes = 4.0 GB

Increase that amount by the suggested starting size of 16
GB:

4 + 16 = 20 GB

Archive log: Suggested size with a
full database backup every day

60 GB '

Because of the requirement to be able to store archive logs
across three backup cycles, multiply the estimate for the
active log by 3 to estimate the total archive log requirement:

4 GB x 3 =12 GB

Increase that amount by the suggested starting size of 48
GB:

12 + 48 = 60 GB
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Table 9. Full database backups (continued)

Example
Item values Description
Archive log: Suggested size with a 132 GB ' Because of the requirement to be able to store archive logs
full database every week across three server database-backup cycles, multiply the

estimate for the active log by 3 to estimate the total archive
log requirement. Multiply the result by the number of days
between full database backups:

(4 GBx3)x7=284GB

Increase that amount by the suggested starting size of 48
GB:

84 + 48 = 132 GB

! The example values in this table are used only to illustrate how the sizes for active logs and archive logs are
calculated. In a production environment that does not use deduplication, 16 GB is the suggested minimum size for
an active log. The suggested starting size for an archive log in a production environment that does not use
deduplication is 48 GB. If you substitute values from your environment and the results are larger than 16 GB and 48
GB, use your results to size the active log and archive log.

Monitor your logs and adjust their size if necessary.

Example: Estimating active and archive log sizes for data deduplication
operations:

If you deduplicate data, you must consider its effects on space requirements for
active and archive logs.

The following factors affect requirements for active and archive log space:

The amount of deduplicated data
The effect of data deduplication on the active log and archive log space
depends on the percentage of data that is eligible for deduplication. If the
percentage of data that can be deduplicated is relatively high, more log
space is required.

The size and number of extents
Approximately 1,500 bytes of active log space are required for each extent
that is identified by a duplicate-identification process. For example, if
250,000 extents are identified by a duplicate-identification process, the
estimated size of the active log is 358 MB:

250,000 extents identified during each process x 1,500 bytes
for each extent = 358 MB

Consider the following scenario. Three hundred backup-archive clients
back up 100,000 files each night. This activity creates a workload of
30,000,000 files. The average number of extents for each file is two.
Therefore, the total number of extents is 60,000,000, and the space
requirement for the archive log is 84 GB:

60,000,000 extents x 1,500 bytes for each extent = 84 GB

A duplicate-identification process operates on aggregates of files. An
aggregate consists of files that are stored in a given transaction, as
specified by the TXNGROUPMAX server option. Suppose that the TXNGROUPMAX
server option is set to the default of 4096. If the average number of extents
for each file is two, the total number of extents in each aggregate is 8192,
and the space required for the active log is 12 MB:
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8192 extents in each aggregate x 1500 bytes for each extent =
12 MB

The timing and number of the duplicate-identification processes

The timing and number of duplicate-identification processes also affects the
size of the active log. Using the 12 MB active-log size that was calculated
in the preceding example, the concurrent load on the active log is 120 MB
if 10 duplicate-identification processes are running in parallel:

12 MB for each process x 10 processes = 120 MB

File size

Large files that are processed for duplicate identification can also affect the
size of the active log. For example, suppose that a backup-archive client
backs up an 80 GB, file-system image. This object can have a high number
of duplicate extents if, for example, the files included in the file system
image were backed up incrementally. For example, assume that a file
system image has 1.2 million duplicate extents. The 1.2 million extents in
this large file represent a single transaction for a duplicate-identification
process. The total space in the active log that is required for this single
object is 1.7 GB:

1,200,000 extents x 1,500 bytes for each extent = 1.7 GB

If other, smaller duplicate-identification processes occur at the same time as
the duplicate-identification process for a single large object, the active log
might not have enough space. For example, suppose that a storage pool is
enabled for deduplication. The storage pool has a mixture of data,
including many relatively small files that range from 10 KB to several
hundred KB. The storage pool also has few large objects that have a high
percentage of duplicate extents.

To take into account not only space requirements but also the timing and
duration of concurrent transactions, increase the estimated size of the
active log by a factor of two. For example, suppose that your calculations
for space requirements are 25 GB (23.3 GB + 1.7 GB for deduplication of a
large object). If deduplication processes are running concurrently, the
suggested size of the active log is 50 GB. The suggested size of the archive
log is 150 GB.

The examples in the following tables show calculations for active and
archive logs. The example in the first table uses an average size of 700 KB
for extents. The example in the second table uses an average size of 256
KB. As the examples show, the average deduplicate-extent size of 256 KB
indicates a larger estimated size for the active log. To minimize or prevent
operational problems for the server, use 256 KB to estimate the size of the
active log in your production environment.

Table 10. Average duplicate-extent size of 700 KB

Item

Example values Description

Size of largest single
object to deduplicate

800 GB

4 TB The granularity of processing for deduplication is at the file
level. Therefore, the largest single file to deduplicate
represents the largest transaction and a correspondingly
large load on the active and archive logs.

Average size of
extents

700 KB

700 KB The deduplication algorithms use a variable block method.
Not all deduplicated extents for a given file are the same
size, so this calculation assumes an average size for extents.
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Table 10. Average duplicate-extent size of 700 KB (continued)

Suggested size

Item Example values Description

Extents for a given 1,198,372 6,135,667 bits | Using the average extent size (700 KB), these calculations

file bits represent the total number of extents for a given object.
The following calculation was used for an 800 GB object:
(800 GB + 700 KB) = 1,198,372 bits
The following calculation was used for a 4 TB object: (4 TB +
700 KB) = 6,135,667 bits

Active log: Suggested |1.7 GB 8.6 GB The estimated active log space that are needed for this

size that is required transaction.

for the deduplication

of a single large object

during a single

duplicate-

identification process

Active log: Suggested |66 GB' 79.8 GB ! After considering other aspects of the workload on the

total size server in addition to deduplication, multiply the existing
estimate by a factor of two. In these examples, the active log
space required to deduplicate a single large object is
considered along with previous estimates for the required
active log size.
The following calculation was used for multiple transactions
and an 800 GB object:
(23.3 GB + 1.7 GB) x 2 = 50 GB
Increase that amount by the suggested starting size of 16 GB:
50 + 16 = 66 GB
The following calculation was used for multiple transactions
and a 4 TB object:
(23.3 GB + 8.6 GB) x 2 = 63.8 GB
Increase that amount by the suggested starting size of 16 GB:
63.8 + 16 = 79.8 GB

Archive log: 198 GB ! 2394 GB' Multiply the estimated size of the active log by a factor of 3.

The following calculation was used for multiple transactions
and an 800 GB object:

50 GB x 3 = 150 GB
Increase that amount by the suggested starting size of 48 GB:
150 + 48 = 198 GB

The following calculation was used for multiple transactions
and a 4 TB object:

63.8 GB x 3 = 191.4 GB
Increase that amount by the suggested starting size of 48 GB:

191.4 + 48 = 239.4 GB
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Table 10. Average duplicate-extent size of 700 KB (continued)

Item

Example values

| Description

! The example values in this table are used only to illustrate how the sizes for active logs and archive logs are
calculated. In a production environment that uses deduplication, 32 GB is the suggested minimum size for an active
log. The suggested minimum size for an archive log in a production environment that uses deduplication is 96 GB.
If you substitute values from your environment and the results are larger than 32 GB and 96 GB, use your results to

size the active log and archive log.

Monitor your logs and adjust their size if necessary.

Table 11. Average duplicate-extent size of 256 KB

Item Example values Description
Size of largest single |800 GB 4TB The granularity of processing for deduplication is at the file
object to deduplicate level. Therefore, the largest single file to deduplicate
represents the largest transaction and a correspondingly
large load on the active and archive logs.
Average size of 256 KB 256 KB The deduplication algorithms use a variable block method.
extents Not all deduplicated extents for a given file are the same
size, so this calculation assumes an average extent size.
Extents for a given 3,276,800 bits |16,777,216 Using the average extent size, these calculations represent
file bits the total number of extents for a given object.
The following calculation was used for multiple transactions
and an 800 GB object:
(800 GB + 256 KB) = 3,276,800 bits
The following calculation was used for multiple transactions
and a 4 TB object:
(4 TB + 256 KB) = 16,777,216 bits
Active log: Suggested |4.5 GB 23.4 GB The estimated size of the active log space that is required for

size that is required
for the deduplication
of a single large object
during a single
duplicate-
identification process

this transaction.
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Table 11. Average duplicate-extent size of 256 KB (continued)

Item Example values Description
Active log: Suggested |71.6 GB ! 109.4 GB ' After considering other aspects of the workload on the
total size server in addition to deduplication, multiply the existing

estimate by a factor of 2. In these examples, the active log
space required to deduplicate a single large object is
considered along with previous estimates for the required
active log size.

The following calculation was used for multiple transactions
and an 800 GB object:

(23.3 GB + 4.5 GB) x 2 = 55.6 GB
Increase that amount by the suggested starting size of 16 GB:
55.6 + 16 = 71.6 GB

The following calculation was used for multiple transactions
and a 4 TB object:

(23.3 GB + 23.4 GB) x 2 = 93.4 GB
Increase that amount by the suggested starting size of 16 GB:

93.4 + 16 = 109.4 GB

Archive log: 2148 GB! 3282 GB'! The estimated size of the active log multiplied by a factor of
Suggested size 3.

The following calculation was used for an 800 GB object:
55.6 GB x 3 = 166.8 GB

Increase that amount by the suggested starting size of 48 GB:
166.8 + 48 = 214.8 GB

The following calculation was used for a 4 TB object:
93.4 GB x 3 = 280.2 GB

Increase that amount by the suggested starting size of 48 GB:

280.2 + 48 = 328.2 GB

! The example values in this table are used only to illustrate how the sizes for active logs and archive logs are
calculated. In a production environment that uses deduplication, 32 GB is the suggested minimum size for an active
log. The suggested minimum size for an archive log in a production environment that uses deduplication is 96 GB.
If you substitute values from your environment and the results are larger than 32 GB and 96 GB, use your results to
size the active log and archive log.

Monitor your logs and adjust their size if necessary.
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Active-log mirror space
The active log can be mirrored so that the mirrored copy can be used if the active
log files cannot be read. There can be only one active log mirror.

Creating a log mirror is a suggested option. If you increase the size of the active
log, the log mirror size is increased automatically. Mirroring the log can affect
performance because of the doubled 1/0O activity that is required to maintain the
mirror. The additional space that the log mirror requires is another factor to
consider when deciding whether to create a log mirror.

If the mirror log directory becomes full, the server issues error messages to the
activity log and to the db2diag.1og. Server activity continues.

Archive-failover log space
The archive failover log is used by the server if the archive log directory runs out
of space.

Specifying an archive failover log directory can prevent problems that occur if the
archive log runs out of space. If both the archive log directory and the drive or file
system where the archive failover log directory is located become full, the data
remains in the active log directory. This condition can cause the active log to fill
up, which causes the server to halt.

Monitoring space utilization for the database and recovery

logs

To determine the amount of used and available active log space, you issue the
QUERY LOG command. To monitor space utilization in the database and recovery
logs, you can also check the activity log for messages.

Active log

If the amount of available active log space is too low, the following messages are
displayed in the activity log:

ANR4531I: IC_AUTOBACKUP_LOG_USED_SINCE_LAST_BACKUP_TRIGGER
This message is displayed when the active log space exceeds the maximum
specified size. The Tivoli Storage Manager server starts a full database
backup.

To change the maximum log size, halt the server. Open the dsmserv.opt
file, and specify a new value for the ACTIVELOGSIZE option. When you are
finished, restart the server.

ANRO0297I: IC_BACKUP_NEEDED_LOG_USED_SINCE_LAST_BACKUP
This message is displayed when the active log space exceeds the maximum
specified size. You must back up the database manually.

To change the maximum log size, halt the server. Open the dsmserv.opt
file, and specify a new value for the ACTIVELOGSIZE option. When you are
finished, restart the server.

ANR45291: IC_AUTOBACKUP_LOG_UTILIZATION_TRIGGER
The ratio of used active-log space to available active-log space exceeds the
log utilization threshold. If at least one full database backup has occurred,
the Tivoli Storage Manager server starts an incremental database backup.
Otherwise, the server starts a full database backup.
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ANRO0295I: IC_BACKUP_NEEDED_LOG_UTILIZATION
The ratio of used active-log space to available active-log space exceeds the
log utilization threshold. You must back up the database manually.

Archive log

If the amount of available archive log space is too low, the following message is
displayed in the activity log:

ANRO0299I: IC_BACKUP_NEEDED_ARCHLOG_USED
The ratio of used archive-log space to available archive-log space exceeds
the log utilization threshold. The Tivoli Storage Manager server starts a full
automatic database backup.

Database

If the amount of space available for database activities is too low, the following
messages are displayed in the activity log:

ANR2992W: IC_LOG_FILE_SYSTEM_UTILIZATION_WARNING_2
The used database space exceeds the threshold for database space
utilization. To increase the space for the database, use the EXTEND DBSPACE
command, the EXTEND DBSPACE command, or the DSMSERV FORMAT
utility with the DBDIR parameter.

ANR1546W: FILESYSTEM_DBPATH_LESS_1GB
The available space in the directory where the server database files are
located is less than 1 GB.

When a Tivoli Storage Manager server is created with the DSMSERV
FORMAT utility or with the configuration wizard, a server database and
recovery log are also created. In addition, files are created to hold database
information used by the database manager. The path specified in this
message indicates the location of the database information used by the
database manager. If space is unavailable in the path, the server can no
longer function.

You must add space to the file system or make space available on the file
system or disk.

Server naming best practices

26

Use these descriptions as a reference when you install or upgrade a Tivoli Storage
Manager server.

Instance user ID

The instance user ID is used as the basis for other names related to the server
instance. The instance user ID is also called the instance owner.

For example: tsminst1

The instance user ID is the user ID that must have ownership or read/write access
authority to all directories that you create for the database and the recovery log.
The standard way to run the server is under the instance user ID. That user ID
must also have read/write access to the directories that are used for any FILE
device classes.
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Home directory for the instance user ID

The home directory can be created when creating the instance user ID, by
using the option (-m) to create a home directory if it does not exist already.
Depending on local settings, the home directory might have the form:
/home/instance_user_ID

For example: /home/tsminstl

The home directory is primarily used to contain the profile for the user ID
and for security settings.

Database instance name

The database instance name must be the same as the instance user ID
under which you run the server instance.

For example: tsminstl
Instance directory

The instance directory is a directory that contains files specifically for a server
instance (the server options file and other server-specific files). It can have any
name that you want. For easier identification, use a name that ties the directory to
the instance name.

You can create the instance directory as a subdirectory of the home
directory for the instance user ID. For example: /home/instance_user_ID/
instance_user_ID

The following example places the instance directory in the home directory
for user ID tsminstl: /home/tsminstl/tsminstl

You can also create the directory in another location, for example:
/tsmserver/tsminstl

The instance directory stores the following files for the server instance:
* The server options file, dsmserv.opt

* The server key database file, cert.kdb, and the .arm files (used by clients
and other servers to import the Secure Sockets Layer certificates of the
server)

* Device configuration file, if the DEVCONFIG server option does not specify
a fully qualified name

* Volume history file, if the VOLUMEHISTORY server option does not specify a
fully qualified name

* Volumes for DEVTYPE=FILE storage pools, if the directory for the
device class is not fully specified, or not fully qualified

¢ User exits
* Trace output (if not fully qualified)

Database name

The database name is always TSMDBI, for every server instance. This name cannot
be changed.
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Server name

The server name is an internal name for Tivoli Storage Manager, and is used for
operations that involve communication among multiple Tivoli Storage Manager
servers. Examples include server-to-server communication and library sharing.

If you use the wizard, the default name that is suggested is the host name of the
system that you are using. You can use a different name that is meaningful in your
environment. If you have more than one server on the system and you use the
wizard, you can use the default name for only one of the servers. You must enter a
unique name for each server.

For example:

PAYROLL

SALES
For more information about server names, see the Administrator’s Guide.
Directories for database space and recovery log

The directories can be named according to local practices. For easier identification,
consider using names that tie the directories to the server instance.

For example, for the archive log:
/tsminstl archlog

Installation directories

Installation directories for the Tivoli Storage Manager server include the server,
DB2, device, language, and other directories. Each one contains several additional
directories.

The default directories and their subdirectories are listed here for the server, DB2,
devices, and languages:

* Server directory (/opt/tivoli/tsm/server/bin), which contains:
— Server code and licensing
e Additional server directories:

— The command and message help are in the /opt/tivoli/tsm/server/bin
directory.

e DB2 directories

The DB2 product that is installed as part of the installation of the Tivoli Storage
Manager server has the directory structure as documented in DB2 information
sources. Protect these directories and files as you do the server directories.

— Jopt/tivoli/tsm/db2
* Device directories
— /usr/kernel/drv/
— Jusr/kernel/drv/sparcv9 for SPARC architecture
* Language directory
Language-dependent portions of the program are located here:
/opt/tivoli/tsm/server/bin
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You can use US English, German, French, Italian, Spanish, Brazilian Portuguese,
Korean, Japanese, traditional Chinese, simplified Chinese, Chinese GBK, Chinese
Big5, and Russian.
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Chapter 2. Installing the Tivoli Storage Manager server
components

To install the Tivoli Storage Manager 7.1 server, you can use the graphical
installation wizard, the command line in console mode, or silent mode.

About this task

Planning to install b Installing components h Taking the first steps

Using the Tivoli Storage Manager installation software, you can install the
following components:

* Tivoli Storage Manager Server

Tip: The database (DB2) and the Global Security Kit (GSKit) are automatically
installed when you select the server component.

* Tivoli Storage Manager Server Languages
* Tivoli Storage Manager License
* Tivoli Storage Manager Devices
* Tivoli Storage Manager Operations Center
* Tivoli Storage Manager Storage Agent
See the Storage Agent User’s Guide for more details about storage agents.

Obtaining the Tivoli Storage Manager installation package

You can obtain the installation package from the product DVD or from an IBM
download site.

Before you begin

If you plan to download the files, set the system user limit for maximum file size

to unlimited to ensure that the files can be downloaded correctly.
1. To query the maximum file size value, issue the following command:
ulimit -Hf

2. If the system user limit for maximum file size is not set to unlimited, change it

to unlimited by following the instructions in the documentation for your
operating system.

About this task

If you obtain the package from the product DVD, ensure that the installation files

are visible on the DVD drive.

If you obtain the package from an IBM download site, you must extract the
installation files.

© Copyright IBM Corp. 1993, 2013
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Procedure

1. Download the appropriate package file from one of the following websites, or
you can access the files from the product DVD:

e For a first time installation or a new release go to Passport Advantage® at:
[http:/ /www.ibm.com /software /lotus /passportadvantage /| Passport
Advantage is the only site that you can download a licensed package file

from.

* For the latest information, updates, and maintenance fixes, go to the Tivoli
Storage Manager support site: |http: / /www.ibm.com/ support/entry/portal/ |
[Overview /Software /Tivoli/ Tivoli_Storage_Manager|

2. If you download the package from one of the download sites, complete the
following steps:

a. Verify that you have enough space to store the installation files

C.

d.

when they are extracted from the product package. See the
download document for the space requirements:

+ Tivoli Storage Manager: |http:/ /www.ibm.com /support/|
[docview.wss?uid=swg24035122]

* Tivoli Storage Manager Extended Edition: lhttp:/ /www.ibm.com /|
lsupport/docview.wss?uid=swg24035635

* System Storage® Archive Manager: |http://www.ibm.com /|
lsupport/docview.wss?uid=swg24035637]

Download the package file to the directory of your choice. The path
must contain no more than 128 characters. Be sure to extract the
installation files to an empty directory. Do not extract to a directory
that contains previously extracted files, or any other files.

Also, ensure that you have executable permission for the package
file.

If necessary, change the file permissions by issuing the following
command:

chmod a+x package_name.bin
Issue the following command to extract the installation files:
./package_name .bin

where package_name is like the following example:
7.1.0.000-TIV-TSMSRV-Solaris.bin

3. Ensure that the following command is enabled so that the Tivoli Storage
Manager wizards work properly:

logins

By default, the command is enabled.

4. Select one of the following methods of installing Tivoli Storage Manager:

“Installing Tivoli Storage Manager by using the installation wizard” on page|

53

“Installing Tivoli Storage Manager by using console mode” on page 34

“Installing Tivoli Storage Manager in silent mode” on page 35|

5. After you install Tivoli Storage Manager, and before you customize it for your
use, 2o to the following website: [http: / /www.ibm.com/ support/entry/portal / |

Overview /Software/Tivoli/Tivoli_Storage_Manager| Click Support and
g g pp

downloads and apply any applicable fixes.
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Installing Tivoli Storage Manager by using the installation wizard

You can install or update Tivoli Storage Manager by using the IBM Installation
Manager graphical wizard.

Before you begin

Ensure that you review the following important information about installing the

server:

* Verify that the operating system is set to the language that you require. By
default, the language of the operating system is the language of the installation
wizard.

* Ensure that the LD_LIBRARY_PATH_64 environment variable is not set.

On test servers only: Use the following command to bypass prerequisite checks
such as the operating system and the required memory. Do not issue this
command on a production server.

./install.sh -g -vmargs "-DBYPASS_TSM_REQ CHECKS=true"
Procedure

Choose whether to install from a downloaded package file, or from the DVD, and
complete the following steps to begin the installation:

Option Description

Installing from a downloaded package file: |4 Change to the directory where you

downloaded the package file.

2. Start the graphical interface installation
wizard by issuing the following
command:

./install.sh

Installing from DVD media: 1. Insert the DVD into the DVD drive.
Tip: Ensure that the installation files are
visible on the DVD drive.

2. Start the graphical interface installation
wizard by issuing the following
command:

./install.sh

What to do next

 If errors occur during the installation process, these errors are recorded in log
files that are stored in the IBM Installation Manager logs directory.

You can view installation log files by clicking File > View Log from the
Installation Manager tool. To collect these log files, click Help > Export Data for
Problem Analysis from the Installation Manager tool.

* After you install Tivoli Storage Manager, and before you customize it for your
use, go to the following website: [http:/ /www.ibm.com /support/entry/portal /|
[Overview /Software /Tivoli/Tivoli Storage Manager] Click Support and
downloads and apply any applicable fixes.
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» After you install a new Tivoli Storage Manager server, review [Taking the firs

[steps after you install Tivoli Storage Manager] to learn about configuring your
server.

Installing Tivoli Storage Manager by using console mode

34

You can install or update Tivoli Storage Manager by using the command line in
console mode.

Before you begin

Ensure that you review the following important information about installing:

* Verify that the operating system is set to the language that you require. By
default, the language of the operating system is the language of the installation
wizard.

* Ensure that the LD_LIBRARY_PATH_64 environment variable is not set.

On test servers only: Use the following command to bypass prerequisite checks
such as the operating system and the required memory. Do not issue this
command on a production server.

./install.sh -c -vmargs "-DBYPASS_TSM_REQ_CHECKS=true"
Procedure

Choose whether to install from a downloaded package file, or from the DVD, and
complete the following steps to begin the installation:

Option Description

Installing from a downloaded package file: |1 Change to the directory where you

downloaded the package file.

2. Start the installation wizard in console
mode, by issuing the following
command:

./install.sh -c

You can generate a response file as part
of a console mode installation. Complete
the console mode installation options,
and in the Summary panel, specify G to
generate the responses.

Installing from DVD media: 1. Insert the DVD into the DVD drive.
Tip: Ensure that the installation files are
visible on the DVD drive.

2. Start the installation wizard in console
mode, by issuing the following
command:

./install.sh -c

You can generate a response file as part
of a console mode installation. Complete
the console mode installation options,
and in the Summary panel, specify G to
generate the responses.
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What to do next

 If errors occur during the installation process, these errors are recorded in log
files that are stored in the IBM Installation Manager logs directory.

You can view installation log files by clicking File > View Log from the
Installation Manager tool. To collect these log files, click Help > Export Data for
Problem Analysis from the Installation Manager tool.

 After you install Tivoli Storage Manager, and before you customize it for your
use, go to the following website: [http: //www.ibm.com /support/entry /portal /|
[Overview /Software/ Tivoli/ Tivoli_Storage_Manager]| Click Support and
downloads and apply any applicable fixes.

Installing Tivoli Storage Manager in silent mode

You can install or update the IBM Tivoli Storage Manager server in silent mode
without any user interaction.

Before you begin

A silent installation can use response files for data input. The following sample
response files are provided for installing, updating, and uninstalling the server:
e install_response_sample.xml

e update_response_sample.xml

* uninstall_response_sample.xml

If you want to use one of the sample response files, they can be found after you
extract the package files, in the input subdirectory. You can use these sample files
as they are or you can customize them to suit your needs. It is optimal to use the
sample response files. These sample files contain instructions and default values to
help you avoid any unnecessary warnings.

On test servers only: Use the following command to bypass prerequisite checks
such as the operating system and the required memory. Do not issue this
command on a production server.

./install.sh -s -acceptlLicense -vmargs "-DBYPASS_TSM REQ CHECKS=true"

Procedure

1. Create a response file, or use one of the sample response files such as
install_response_sample.xml or update response_sample.xml.

2. To start the silent installation, issue one of the following commands from the
directory where the installation package file is extracted:

Option Description

Installing from a To start the installation by accepting the default values,
downloaded package file or |issue the following command:

DVD media: ./install.sh -s -acceptlLicense

To start the installation with a custom response file, issue
the following command, where response_file represents the
response file path, including the file name:

./install.sh -s -input response_file -acceptLicense
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What to do next

* If errors occur during the installation process, these errors are recorded in log
files that are stored in the IBM Installation Manager logs directory.

You can view installation log files by clicking File > View Log from the
Installation Manager tool. To collect these log files, click Help > Export Data for
Problem Analysis from the Installation Manager tool.

 After you install Tivoli Storage Manager, and before you customize it for your
use, go to the following website: [http: //www.ibm.com /support/entry /portal /|
[Overview /Software/ Tivoli/ Tivoli_Storage_Manager] Click Support and
downloads and apply any applicable fixes.

* After you install a new Tivoli Storage Manager server, review the information in
Taking the first steps after you install Tivoli Storage Manager to learn about
configuring your server.

Installing server language packages

Translations for the IBM Tivoli Storage Manager server allow the server to display
messages and help in languages other than U.S. English. The translations also
allow for the use of locale conventions for date, time, and number formatting.

Server language locales

Use either the default language package option or select another language package
to display server messages and help.

This language package is automatically installed for the following default language
option for Tivoli Storage Manager server messages and help:

* LANGUAGE AMENG

The following system locale must be installed on the system when you use
LANGUAGE AMENG:

en_US

For languages or locales other than the default, install the language package that
your installation requires.

You can use the languages that are shown:

Table 12. Server languages for Solaris

Language LANGUAGE option value
Chinese, Simplified zh
zh_CN.UTF-8
Chinese, Traditional zh_ TW
zh_TW.BIG5
zh_TW.UTE-8
English AMENG (default)
en_US.UTF-8
French fr_FR.ISO8859-1
fr_FR.UTF-8
German de_DE.ISO8859-1
de_DE.UTF-8
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Table 12. Server languages for Solaris (continued)

Language LANGUAGE option value

Italian it_IT.ISO8859-1
it_IT.UTE-8

Japanese ja
ja_JP.UTE-8

Korean ko
ko_KR.UTF-8

Portuguese, Brazilian pt_BR.ISO8859-1
pt_BR.UTE-8

Russian ru_RU.ISO8859-5
ru_RU.UTE-8

Spanish es_ES.ISO8859-1
es_ES.UTF-8

Notes:

* LANGUAGE AMENG requires system locale en_US.

* For more information about setting the LANGUAGE option, see the Administrator’s

Reference.

Restriction: For Operations Center users, some characters might not be displayed
properly if the web browser does not use the same language as the server. If this
problem occurs, set the browser to use the same language as the server.

Configuring a language package
After you configure a language package, messages and help are shown on the

Tivoli Storage Manager in languages other than US English. Installation packages
are provided with Tivoli Storage Manager.

About this task

To set support for a certain locale, complete one of the following tasks:

* Set the LANGUAGE option in the server options file to the name of the locale that
you want to use. For example:

To use the it_IT.IS08859-1 locale, set the LANGUAGE option to
it_IT.1S08859-1. See|“Server language locales” on page 36,

* If you are starting the server in the foreground, set the LC_ALL environment
variable to match the value that is set in the server options file. For example, to
set the environment variable for Italian, enter the following value:

export LC_ALL=it_IT
If the locale is successfully initialized, it formats the date, time, and number for the

server. If the locale is not successfully initialized, the server uses the US English
message files and the date, time, and number format.
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Updating a language package

You can modify or update a language package by using the IBM Installation
Manager.

About this task

You can install another language package within the same Tivoli Storage Manager
instance.

* Use the Modify function of IBM Installation Manager to install another language
package.

* Use the Update function of IBM Installation Manager to update to newer
versions of the language packages.

Tip: In IBM Installation Manager, the term update means to discover and install
updates and fixes to installed software packages. In this context, update and upgrade
are synonymous.
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Chapter 3. Taking the first steps after you install Tivoli
Storage Manager

After you install Tivoli Storage Manager Version 7.1, prepare for the configuration.
Using the configuration wizard is the preferred method of configuring the Tivoli
Storage Manager instance.

About this task

Planning to install h Installing components » Taking the first steps

Figure 2. You are in the configuring the Tivoli Storage Manager server section.

Configure the Tivoli Storage Manager server instance by completing the following
steps:

1. Update the kernel parameter values.

See [‘Tuning kernel parameters” on page 40

2. Create the directories and user ID for the server instance. See |”Creating tha
[user ID and directories for the server instance” on page 41

3. Configure a Tivoli Storage Manager instance. Select one of the following
options:

* Use the Tivoli Storage Manager configuration wizard, the preferred method.
See|’Configuring Tivoli Storage Manager using the configuration wizard” on|
|Eage 43.|

* Manually configure the new Tivoli Storage Manager instance. See

[’Configuring the server instance manually” on page 44| Complete the
following steps during a manual configuration.

a. Set up your directories and create the Tivoli Storage Manager instance.
See [“Creating the server instance” on page 44|

b. Create a new server options file by copying the sample file to set up
communications between the server and clients. See [“Configuring server|
|and client communications” on page 46l

c. Issue the DSMSERV FORMAT command to format the database. See
[“Formatting the database and log” on page 50.|

d. Configure your system for database backup. See [“Preparing the database]
Imanager for database backup” on page 50|

4. Configure options to control when database reorganization runs. See
[“Configuring server options for server database maintenance” on page 52
5. Start the Tivoli Storage Manager server instance if it is not already started.
See [‘Starting the server instance” on page 53
6. Register your license. See [‘Registering licenses” on page 58]
7

. Prepare your system for database backups. See [“Specifying a device class in]
[preparation for database backups” on page 58|

8. Monitor the server. See [“Monitoring the server” on page 59
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Tuning kernel parameters

For IBM Tivoli Storage Manager and DB2 to install and operate correctly on Oracle
Solaris, you must update the kernel configuration parameters.

About this task

If you do not update these parameters, the installation of DB2 and Tivoli Storage
Manager might fail. Even if installation is successful, operational problems might
occur if you do not set parameter values.

Using the db2osconf utility

Use the db2osconf utility to get preferred changes based on the size of your
system. The utility checks the settings of the kernel configuration parameters and
suggests updates to improve performance.

About this task

The db2osconf utility does not change the settings in the /etc/system file. You
must run the db2esconf utility after installing Tivoli Storage Manager. If you
update a kernel parameter, you must restart the system.

The suggested updates provided by the db2osconf utility are the minimum settings
required to run DB2 on your system. In addition to the suggestions made by the
db2osconf utility, other changes are required to run both Tivoli Storage Manager
and DB2.

Procedure

To display a list of options for the db2osconf utility, issue the following command:
db2osconf -h

Results

For Solaris 9 systems, edit the /etc/system file to update kernel parameters. For
Solaris 10 systems, use PROJMOD commands to update the kernel parameters.

For details about the db2esconf utility, go to the DB2 information center:
lhttp:/ /pic.dhe.ibm.com/infocenter /db2luw /v10r5 Search for db2osconf.

Suggested minimum values

Ensure that the values for kernel parameters are sufficient to prevent operational
problems from occurring when running the Tivoli Storage Manager server.

About this task

shows the suggested minimum values for running Tivoli Storage Manager
and DB2 on Solaris 9. [Table 14 on page 41|shows the suggested minimum values
for running Tivoli Storage Manager and DB2 on Solaris 10.

Table 13. Solaris 9 parameter values

Parameter

Description Preferred value

set semsys:seminfo_semume The process-wide maximum number of undo 5120

structures per process
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Table 13. Solaris 9 parameter values (continued)

Parameter

Description

Preferred value

set semsys:seminfo_semmni

The number of semaphore identifiers

6144

set shmsys:shminfo_shmmax The maximum shared-memory segment size 46,369,367,654
set shmsys:shminfo_shmmni The minimum shared-memory segment size 6144

set rlim_fd_max The process open-file descriptors limit 65,536

set rlim_fd_cur The file descriptor limit 4096

Table 14. Solaris 10 parameter values

Parameter Description Preferred value
projmod -a -K "project.max-shm- See note. 46,369,367,654
memory=(privileged,46369367654,deny)"
user.process_owner The total amount of shared memory that is

B allowed for a project
projmod -a -K "project.max-shm- See note. 6144
ids=(privileged,6144,deny)"
user.process_owner The maximum shared memory IDs for a project
projmod -a -K "project.max-msg- See note. 5120
ids=(privileged,5120,deny)"
user.process_owner The maximum message queue IDs for a project
projmod -a -K "project.max-sem- See note. 6144

ids=(privileged,6144,deny)"
user.process_owner

The maximum semaphore IDs for a project

Note: To obtain information about project settings for a process owner on Solaris 10, issue the project -1 command
or check the /etc/project file. If a project does not exist, issue the following command to add a project:

projadd -U process_owner user.process_owner

To specify a project name for the commands that are listed in the table, be sure to add the prefix user. to the name
of the process owner.

Creating the user ID and directories for the server instance

Create the user ID for the Tivoli Storage Manager server instance and create the
directories that the Tivoli Storage Manager server instance needs for database and
recovery logs.

Before you begin

Review the information about planning space for the server before completing this
task. See [“Worksheets for planning details for the Tivoli Storage Manager server”|

I(_)n page 8.|

Procedure

1. Create the user ID that will own the server instance. You use this user ID when
you create the server instance in a later step.

Create a user ID and group that will be the owner of the Tivoli Storage
Manager server instance.

a. The following commands can be run from an administrative user ID
that will set up the user and group. Create the user ID and group in
the home directory of the user.
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Restriction: In the user ID, only lowercase letters (a-z), numerals
(0-9), and the underscore character ( _ ) can be used. The user ID
and group name must comply with the following rules:

* The length must be 8 characters or less.

* The user ID and group name cannot start with ibm, sql, sys, or a
numeral.

* The user ID and group name cannot be user, admin, guest, public,
local, or any SQL reserved word.

For example, create user ID tsminstl in group tsmsrvrs. The
following examples show how to create this user ID and group
using operating system commands.
groupadd tsmsrvrs
useradd -d /export/home/tsminstl -m -g tsmsrvrs

-s /bin/ksh tsminstl
passwd tsminstl

Restriction: DB2 does not support direct operating system user
authentication through LDAP.

b. Log off, then log in to your system. Change to the user account that
you just created. Use an interactive login program, such as telnet, so
that you are prompted for the password and can change it if
necessary.

2. Create directories that the server requires. Ensure that you are logged in under
the new user ID you just created.

Create empty directories for each of the items shown in the following table. Mount the
associated storage to each directory for the active log, archive log and database directories.

Example commands for
Item creating the directories Your directories

The instance directory for |mkdir /tsminstl

the server, which is a chown tsminstl /tsminstl
directory that will
contain files specifically
for this server instance
(the server options file
and other server-specific
files)

The database directories |mkdir /tsmdb001
mkdir /tsmdb002
mkdir /tsmdb003
mkdir /tsmdb004

Active log directory mkdir /tsmlog

Archive log directory mkdir /tsmarchlog

Optional: Directory for ~ |mkdir /tsmlogmirror
the log mirror for the
active log

Optional: Secondary mkdir /tsmarchlogfailover
archive log directory
(failover location for
archive log)
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When a server is initially created by using the DSMSERV FORMAT utility or the
configuration wizard, a server database and recovery log are created. In
addition, files are created to hold database information that is used by the
database manager.

3. Log off the new user ID.

Configuring Tivoli Storage Manager

After you have installed Tivoli Storage Manager Version 7.1 and prepared for the
configuration, configure the Tivoli Storage Manager server instance.

About this task

Configure a Tivoli Storage Manager server instance by selecting one of the
following options:

* Use the Tivoli Storage Manager configuration wizard on your local system. See
[“Configuring Tivoli Storage Manager using the configuration wizard.”|

* Manually configure the new Tivoli Storage Manager instance. See
[the server instance manually” on page 44 Complete the following steps during
a manual configuration.

1. Set up the directories and create the Tivoli Storage Manager instance. See
[“Creating the server instance” on page 44|

2. Create a new server options file by copying the sample file in order to set up
communications between the Tivoli Storage Manager server and clients. See
[“Configuring server and client communications” on page 46}

3. Issue the DSMSERV FORMAT command to format the database. See
[“Formatting the database and log” on page 50

4. Configure your system for database backup. See [“Preparing the database]
[manager for database backup” on page 50.

Configuring Tivoli Storage Manager using the configuration
wizard

The wizard offers a guided approach to configuring a server. By using the
graphical user interface (GUI), you can avoid some configuration steps that are
complex when done manually. Start the wizard on the system where you installed
the Tivoli Storage Manager server program.

Before you begin

Before beginning the configuration wizard, you must complete all preceding steps
to prepare for the configuration, including installing Tivoli Storage Manager,
creating the database and log directories, and creating the directories and user ID
for the server instance.

Procedure
1. Ensure that the following requirements are met:

¢ The system where you installed Tivoli Storage Manager must have the X
Window System client. You must also be running an X Window System
server on your desktop.

¢ The system must have one of the following protocols enabled. Ensure that
the port that the protocol uses is not blocked by a firewall.
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2.

— Secure Shell (SSH). Ensure that the port is set to the default value, 22.
Also, ensure that the SSH daemon service has access rights for connecting
to the system by using localhost.

— Remote shell (RSH).
— Remote Execution Protocol (REXEC).

* You must be able to log in to Tivoli Storage Manager with the user ID that
you created for the server instance, by using the SSH, RSH, or REXEC
protocol. When using the wizard, you must provide this user ID and
password to access that system.

Start the local version of the wizard:

Open the dsmicfgx program in the /opt/tivoli/tsm/server/bin directory.
This wizard can only be run as a root user.

Follow the instructions to complete the configuration. The wizard can be
stopped and restarted, but the server is not operational until the entire
configuration process is complete.

Configuring the server instance manually

After installing Tivoli Storage Manager Version 7.1, you can configure Tivoli
Storage Manager manually instead of using the configuration wizard.

Creating the server instance

Cre

ate a Tivoli Storage Manager instance by issuing the db2icrt command.

About this task

You can have one or more server instances on one workstation.

Important: Before you run the db2icrt command, verify the following items:

* The home directory for the user (/home/tsminstl) exists. If there is no home
directory, you must create it.

The instance directory stores the following core files that are generated by the
Tivoli Storage Manager server:

The server options file, dsmserv.opt

The server key database file, cert.kdb, and the .arm files (used by clients and
other servers to import the Secure Sockets Layer certificates of the server)

Device configuration file, if the DEVCONFIG server option does not specify a
fully qualified name

Volume history file, if the VOLUMEHISTORY server option does not specify a
fully qualified name

Volumes for DEVTYPE=FILE storage pools, if the directory for the device
class is not fully specified, or not fully qualified

User exits
Trace output (if not fully qualified)

* A shell configuration file (for example, .profile) exists in the home directory.
The root user and instance-user ID must have write permission to this file. For
more information, see the section on Linux and UNIX environment variable

settings in the DB2 Information Center at |ttp://pic.dhe.ibm.com/infocenter /|
db2luw /v10r5

1. Log in using the root user ID and create a Tivoli Storage Manager instance. The

name of the instance must be the same name as the user that owns the
instance. Use the db2icrt command and enter the command on one line:
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/opt/tivoli/tsm/db2/instance/db2icrt -a server -s ese -u
instance_name instance_name

For example, if your user ID for this instance is tsminstl, use the following
command to create the instance. Enter the command on one line.

/opt/tivoli/tsm/db2/instance/db2icrt -a server -s ese -u
tsminstl tsminstl

Remember: From this point on, use this new user ID when you configure your
Tivoli Storage Manager server. Log out of the root user ID and log in under the
new instance-user ID.

Change the default directory for the database to be the same as the instance
directory for the server. If you have multiple servers, log in under the instance
ID for each server. Issue this command:

db2 update dbm cfg using dftdbpath instance_directory

For example:

db2 update dbm cfg using dftdbpath /tsminstl

Modify the library path to use the version of the IBM Global Security Kit

(GSKit) that is installed with the Tivoli Storage Manager server. In the

following examples, server_bin_directory is a subdirectory of the server

installation directory. For example, /opt/tivoli/tsm/server/bin.

* You must update the following files to set the library path when DB2 or the
Tivoli Storage Manager server are started:
instance_directory/sqllib/usercshrc
instance_directory/sqllib/userprofile

* The following entry is added to the instance_directory/sqllib/usercshrc
file, on one line:
setenv LD_LIBRARY_PATH server_bin_directory/dbbkapi:

Jopt/ibm/gsk8 64/Tib64:$LD_LIBRARY PATH

* The following entries are added to the instance_directory/sql1ib/

userprofile file. Each entry is on one line.

LD_LIBRARY_PATH=server_bin_directory/dbbkapi:
Jopt/ibm/gsk8_64/11b64:$LD_LIBRARY PATH
export LD_LIBRARY_PATH

* Verify the library path settings and that the GSKit is version 8.0.14.14 or later.
Issue the following commands:
echo $LD_LIBRARY_PATH
gsk8capicmd_64 -version
gsk8ver_64
If your GSKit version is not 8.0.14.14 or later, you must reinstall the Tivoli
Storage Manager server. The reinstallation ensures that the correct GSKit
version is available.

Create a new server options file. See |'Configuring server and client
[communications” on page 46
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Configuring server and client communications

A default sample server options file, dsmserv.opt.smp, is created during Tivoli
Storage Manager installation in the /opt/tivoli/tsm/server/bin directory. You
must set up communications between the server and clients by creating a new
server options file. To do so, copy the sample file to the directory for the server
instance.

About this task

Ensure that you have a server instance directory, for example /tsminstl, and copy
the sample file to this directory. Name the new file dsmserv.opt and edit the
options. Complete this set-up before you initialize the server database (see
[“Formatting the database and log” on page 50). Each sample or default entry in
the sample options file is a comment, a line beginning with an asterisk (*). Options
are not case-sensitive and one or more blank spaces are allowed between keywords
and values.

When editing the options file, follow these guidelines:

* Remove the asterisk at the beginning of the line to activate an option.

* Begin entering the options in any column.

* Enter only one option per line, and the option must be on only one line.

* If you make multiple entries for a keyword, the Tivoli Storage Manager server
uses the last entry.

If you change the server options file, you must restart the server for the changes to
take effect. See the Administrator’s Reference for a description of all server options.

You can specify one or more of the following communication methods:
e TCP/IP Version 4 or Version 6

¢ Shared memory

* Simple network management protocol (SNMP) DPI

* Secure Sockets Layer (SSL)

Note: You can authenticate passwords with the LDAP directory server, or
authenticate passwords with the Tivoli Storage Manager server. Passwords that
are authenticated with the LDAP directory server can provide enhanced system
security. For details, see the managing passwords and logon procedures section
in the Administrator’s Guide.

Setting TCP/IP options:

Select from a range of TCP/IP options for the Tivoli Storage Manager server or
retain the default.

About this task

The following is an example of a list of TCP/IP options you can use to set up your
system.

commmethod tcpip
tcpport 1500
tcpwindowsize 0
tcpnodelay yes
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Tip: You can use TCP/IP Version 4, Version 6, or both.

TCPPORT
The server TCP/IP port address. The default value is 1500.

TCPWINDOWSIZE
Specifies the size of the TCP/IP buffer that is used when sending or
receiving data. The window size that is used in a session is the smaller of
the server and client window sizes. Larger window sizes use additional
memory but can improve performance.

You can specify an integer from 0 to 64. To use the default window size for
the operating system, specify 0.

TCPNODELAY
Specifies whether or not the server sends small messages or lets TCP/IP
buffer the messages. Sending small messages can improve throughput but
increases the number of packets sent over the network. Specify YES to
send small messages or NO to let TCP/IP buffer them. The default is YES.

TCPADMINPORT
Specifies the port number on which the server TCP/IP communication
driver is to wait for requests other than client sessions. The default value is
1500.

SSLTCPPORT
(SSL-only) Specifies the Secure Sockets Layer (SSL) port number on which
the server TCP/IP communication driver waits for requests for
SSL-enabled sessions for the command-line backup-archive client and the
command-line administrative client.

SSLTCPADMINPORT
Specifies the port address on which the server TCP/IP communication
driver waits for requests for SSL-enabled sessions for the command-line
administrative client.

Setting shared memory options:

You can use shared memory communications between clients and servers on the
same system. To use shared memory, TCP/IP Version 4 must be installed on the
system.

About this task

Shared memory options is the default communication method.

The following example shows a shared memory setting:

commmethod sharedmem
shmport 1510

In this example, SHMPORT specifies the TCP/IP port address of a server when
using shared memory. Use the SHMPORT option to specify a different TCP/IP
port. The default port address is 1510.

COMMMETHOD can be used multiple times in the IBM Tivoli Storage Manager

server options file, with a different value each time. For example, the following
example is possible:
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commmethod tcpip
commmethod sharedmem

The maximum number of concurrent shared memory sessions is based on available
system resources. Each shared memory session uses one shared memory region of
up to 4 MB, and four IPCS message queues, depending on the Tivoli Storage
Manager client level.

Ensure that you have run the DB2OSCONF utility so that the maximum number of
message queues (MSGMNI) is correct.

If the server and client are not run under the same user ID, then the server must
be root. This prevents shared memory communication errors.

Setting SNMP DPI subagent options:

Tivoli Storage Manager implements a simple network management protocol
(SNMP) subagent. You can configure the SNMP subagent to send traps to an
SNMP manager, such as NetView®, and to provide support for a Management
Information Base (MIB).

About this task

For details about configuring SNMP for use with Tivoli Storage Manager, see the
Administrator’s Guide.

The subagent communicates with the snmp daemon, which in turn communicates
with a management application. The snmp daemon must support the DPI protocol.
Agents are available on AIX. The subagent process is separate from the Tivoli
Storage Manager server process, but the subagent gets its information from a
server options file. When the SNMP management application is enabled, it can get
information and messages from servers.

Use the following SNMP DPI options as an example of a SNMP setting. You must
specify the COMMMETHOD option. For details about the other options, see the
Administrator’s Reference.

commmethod snmp
snmpheartbeatinterval 5
snmpmessagecategory severity

Setting Secure Sockets Layer options:

You can add more protection for your data and passwords by using Secure Sockets
Layer (SSL).

Before you begin

SSL is the standard technology for creating encrypted sessions between servers and
clients. SSL provides a secure channel for servers and clients to communicate over
open communication paths. With SSL, the identity of the server is verified through
the use of digital certificates.
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To ensure better system performance, use SSL only for sessions when it is needed.
Consider adding additional processor resources on the Tivoli Storage Manager
server to manage the increased requirements.

Refer to setting up Transport Layer Security (TLS) in the Administrator’s Guide.
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Formatting the database and log
Use the DSMSERV FORMAT utility to initialize a server instance. No other server
activity is allowed while initializing the database and recovery log.

After you set up server communications, you are ready to initialize the database.
Ensure that you log in by using the instance user ID. Do not place the directories
on file systems that might run out of space. If certain directories (for example, the
archive log) become unavailable or full, the server stops. See [Capacity planning| for
more details.

For optimal performance and to facilitate I/O, specify at least two equally sized
containers or Logical Unit Numbers (LUNSs) for the database. See Optimizing
Performance for more information about the configuration of directories for the
database. In addition, each active log and archive log should have its own
container or LUN.

Initializing a server instance

Use the DSMSERV FORMAT utility to initialize a server instance. For example, issue the
following command:
dsmserv format dbdir=/tsmdb001 activelogsize=8192

activelogdirectory=/activelog archlogdirectory=/archlog
archfailoverlogdirectory=/archfaillog mirrorlogdirectory=/mirroriog

Tip: If DB2 does not start after you issue the DSMSERV FORMAT command, you might
need to disable the file system mount option NOSETUID. If this option is set on the
file system that contains the DB2 instance owner directory, or on any file system
that contains the DB2 database, active logs, archive logs, failover logs, or mirrored
logs, the option must be disabled to start the system.

After you disable the NOSETUID option, remount the file system and then start DB2
by issuing the following command:

db2start

For more information, see the Administrator’s Reference.

Preparing the database manager for database backup

To back up the data in the database to Tivoli Storage Manager, you must enable
the database manager and configure the Tivoli Storage Manager application
programming interface (API).

About this task

Starting with Tivoli Storage Manager V7.1, it is no longer necessary to set the API
password during a manual configuration of the server. If you set the API password

during the manual configuration process, attempts to back up the database might
fail.

If you use the Tivoli Storage Manager configuration wizard to create a Tivoli
Storage Manager server instance, you do not have to complete these steps. If you
are configuring an instance manually, complete the following steps before you
issue either the BACKUP DB or the RESTORE DB commands.
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Attention: If the database is unusable, the entire Tivoli Storage Manager server is
unavailable. If a database is lost and cannot be recovered, it might be difficult or
impossible to recover data that is managed by that server. Therefore, it is critically
important to back up the database.

In the following commands, replace the example values with your actual values.
The examples use tsminstl for the server instance user ID, /tsminstl for the Tivoli
Storage Manager server instance directory, and /home/tsminstl as the server
instance users home directory.

1. Set the Tivoli Storage Manager API environment-variable configuration for the
database instance:

a. Log in using the tsminstl user ID.

b. When user tsminstl is logged in, ensure that the DB2 environment is
properly initialized. The DB2 environment is initialized by running the
/home/tsminstl/sql1ib/db2profile script, which normally runs
automatically from the profile of the user ID. Ensure the .profile file exists
in the instance users home directory, for example, /home/tsminst1/.profile.
If .profile does not run the db2profile script, add the following lines:
if [ -f /home/tsminstl/sql1ib/db2profile ]; then

. /home/tsminst1/sq11ib/db2profile
fi

c. For the instance_directory/sqllib/userprofile file, add the following
lines:
DSMI_CONFIG=server_instance_directory/tsmdbmgr.opt
DSMI_DIR=server bin_directory/dbbkapi

DSMI_LOG=server_instance_directory
export DSMI_CONFIG DSMI_DIR DSMI_LOG

For the instance_directory/sqllib/usercshrc file, add the following lines:

setenv DSMI_CONFIG=server_instance_directory/tsmdbmgr.opt
setenv DSMI_DIR=server bin_directory/dbbkapi
setenv DSMI_LOG=server_instance_directory

2. Log out and log in again as tsminstl, or issue this command:
. V/.profile

Tip: Ensure that you enter a space after the initial dot (.) character.

3. Create a file that is called tsmdbmgr.opt in the server_instance directory, which is
in the /tsminstl directory in this example, and add the following line:
SERVERNAME TSMDBMGR_TSMINST1

Remember: The SERVERNAME that you use must be consistent in the
tsmdbmgr.opt and dsm.sys files.

4. As root user, add the following lines to the Tivoli Storage Manager API dsm.sys
configuration file. The dsm.sys configuration file is in the following default
location:

server_bin directory/dbbkapi/dsm.sys

servername TSMDBMGR_TSMINST1
commmethod tcpip
tcpserveraddr localhost
tcpport 1500

errorlogname /tsminstl
nodename $$ TSMDBMGR_$$

where

* servername matches the servername in tsmdbmgr.opt.
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* commethod is the client API used to contact the server for database backup.
This value can be tcpip or sharedmem. For sharedmem, see step El

* tepserveraddr is the server address that the client API uses to contact the
server for database backup. This value must be localhost for database backup
to work.

* tcpport is the port number that the client API uses to contact the server for
database backup. Ensure that you enter the same tcpport option that is
specified in the dsmserv.opt server options file.

* errorlogname is the error log where the client API logs errors that are
encountered during a database backup. This log is typically in the server
instance directory. The log can, however, be placed anywhere the instance
user ID has write-permission.

* nodename is the node name that the client API uses to connect to the server
during a database backup. This value must be $$§_TSMDBMGR_$$ for a database
backup to work.

5. Optional: Configure the server to back up the database by using shared
memory. In this way, you might be able to reduce the processor load and
improve throughput. Complete the following steps:

a. Review the dsmserv.opt file. If the following lines are not in the file, add
them:

commmethod sharedmem
shmport port_number

where port_number specifies the port to be used for shared memory.
b. In the dsm.sys configuration file, locate the following lines:

commmethod tcpip
tcpserveraddr localhost
tcpport port_number

Replace the specified lines with the following lines:
commmethod sharedmem

shmport port_number

where port_number specifies the port to be used for shared memory.

Configuring server options for server database maintenance

52

To help avoid problems with database growth and server performance, the server
automatically monitors its database tables and reorganizes them when needed.
Before starting the server for production use, set server options to control when
reorganization runs. If you plan to use data deduplication, ensure that the option
to run index reorganization is enabled.

About this task

Table and index reorganization requires significant processor resources, active log
space, and archive log space. Because database backup takes precedence over
reorganization, select the time and duration for reorganization to ensure that the
processes do not overlap and reorganization can complete. For more information
about scheduling reorganization, see the Administrator’'s Guide.

If you update these server options while the server is running, you must stop and
restart the server before the updated values take effect.

IBM Tivoli Storage Manager for Oracle Solaris: Installation Guide



Installing the Tivoli Storage Manager server

Procedure
1. Modify the server options.
Edit the server options file, dsmserv.opt, in the server instance directory. Follow
these guidelines when you edit the server options file:
* To activate an option, remove the asterisk at the beginning of the line.
* Create an option on any line.
* Enter only one option per line. The entire option with its value must be on
one line.
* If you have multiple entries for an option in the file, the server uses the last
entry.
* To view available server options, see the sample file, dsmserv.opt.smp, in the
/opt/tivoli/tsm/server/bin directory.
2. 1If you plan to use data deduplication, enable the ALLONREORGINDEX server
option. Add the following option and value to the server options file:
allowreorgindex yes

3. Set the REORGBEGINTIME and REORGDURATION server options to control when
reorganization starts and how long it runs. Select a time and duration so that
reorganization runs when you expect that the server is least busy. These server
options control both table and index reorganization processes.

a. Set the time for reorganization to start by using the REORGBEGINTIME server
option. Specify the time by using the 24-hour system. For example, to set
the start time for reorganization as 8:30 p.m., specify the following option
and value in the server options file:

reorgbegintime 20:30

b. Set the interval during which the server can start reorganization. For
example, to specify that the server can start reorganization for four hours
after the time set by the REORGBEGINTIME server option, specify the following
option and value in the server options file:

reorgduration 4

4. If the server was running while you updated the server options file, stop and
restart the server.

Starting the server instance

You can start the Tivoli Storage Manager server by using the instance user ID or
the root user ID. You can also use the instance user ID or the root user ID to start
the server automatically.

Before you begin

Ensure that you set access permissions and user limits correctly. For instructions,
see [“Verifying access rights and user limits” on page 54|

About this task

The preferred way to start the server is by using the instance user ID. By using the
instance user ID, you simplify the setup process and avoid potential issues.
However, in some cases, it might be necessary to start the server with the root user
ID. For example, you might want to use the root user ID to ensure that the server
can access specific devices.
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Procedure

To start the server, take one of the following actions:

 Start the server by using the instance user ID. For instructions, see [‘Starting the|
|server from the instance user ID” on page 55.|

» Start the server by using the root user ID. For instructions, see|”“Starting the

[server from the root user ID” on page 56)

* Start the server automatically.

For instructions, see [‘Automatically starting servers” on page 56

For information about other options for starting the server, see the Administrator’s
Guide.

Verifying access rights and user limits
Before you start the server, verify access rights and user limits.

About this task

If you do not verify user limits, also known as ulimits, you might experience server
instability or a failure of the server to respond. You must also verify the
system-wide limit for the maximum number of open files. The system-wide limit
must be greater than or equal to the user limit.

Procedure
1. Verify that the server instance user ID has permissions to start the server.

2. For the server instance that you plan to start, ensure that you have authority to
read and write files in the server instance directory. Verify that the dsmserv.opt
file exists in the server instance directory, and that the file includes parameters
for the server instance.

3. If the server is attached to a tape drive, medium changer, or removable media
device, and you plan to start the server by using the instance user ID, grant
read /write access to the instance user ID for these devices. To set permissions,
take one of the following actions:

* If the system is dedicated to Tivoli Storage Manager and only the Tivoli
Storage Manager administrator has access, make the device special file
world-writable:
chmod +w /dev/rmtX

* If the system has multiple users, you can restrict access by making the Tivoli
Storage Manager instance user ID the owner of the special device files:
chmod u+w /dev/rmtX

* If multiple user instances are running on the same system, change the group
name, for example TAPEUSERS, and add each Tivoli Storage Manager
instance user ID to that group. Then, change the ownership of the device
special files to belong to the group TAPEUSERS, and make them
group-writable:
chmod g+w /dev/rmtX

4. To prevent server failures during interaction with DB2, tune the kernel
parameters.

For instructions about tuning kernel parameters, see [“Tuning kerne

[parameters” on page 40)

5. Verify the following user limits based on the guidelines in the table.
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Table 15. User limit (ulimit) values

User limit type Standard value Command to query value
Maximum size of core files Unlimited ulimit -Hc

created

Maximum size of a data Unlimited ulimit -Hd

segment for a process

Maximum file size Unlimited ulimit -Hf
Maximum number of open | 65536 ulimit -Hn
files

Maximum amount of Unlimited ulimit -Ht

processor time in seconds

To modify user limits, follow the instructions in the documentation for your
operating system.

Tip: If you plan to start the server automatically by using a script, you can set
the user limits in the script.

Ensure that the user limit of maximum user processes (nproc) is set to the
minimum suggested value of 16384.

a. To verify the current user limit, issue the following command by using the
instance user ID:

ulimit -Hu

For example:

[user@Machine ~]$ ulimit -Hu
16384

b. If the limit of maximum user processes is not set to 16384, set the value to
16384.

Add a line to the /etc/security/Timits.conf file.

Starting the server from the instance user ID

To start the server from the instance user ID, log in with the instance user ID and
issue the appropriate command from the server instance directory.

Before you begin

Ensure that access rights and user limits are set correctly. For instructions, see

[“Verifying access rights and user limits” on page 54.

Procedure

1.

2.

Log in to the system where Tivoli Storage Manager is installed by using the
instance user ID for the Tivoli Storage Manager server.

If you do not have a user profile that runs the db2profile script, issue the
following command:

. /home/tsminstl/sq11ib/db2profile

Tip: For instructions about updating the user ID login script to run the
db2profile script automatically, see the DB2 documentation.

Start the server by issuing the following command from the server instance
directory:

/usr/bin/dsmserv
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Tip: The command runs in the foreground so that you can set an administrator
ID and connect to the server instance.

For example, if the name of the Tivoli Storage Manager server instance is
tsminstl and the server instance directory is /tsminstl, you can start the
instance by issuing the following commands:
cd /tsminstl

. ~/sq11ib/db2profile
/usr/bin/dsmserv

Alternatively, if you set up the Tivoli Storage Manager server as a service by
using the Solaris Service Management Facility (SMF), you can start the service
by issuing the svcadm enable command. For instructions, see Technote 7021102
(http:/ /www.ibm.com /support/docview.wss?uid=swg27021102).

Starting the server from the root user ID

The standard way to start the server is by using the instance user ID. However, in
some cases, it might be necessary to use another user ID to start the server. For
example, you might want to use the root user ID to ensure that the server can
access specific devices.

Before you begin

For information about authorizing root users and starting the server by using the
root user ID, see the Administrator’s Guide.

Automatically starting servers

You can configure the server to start automatically at system startup. Use the
rc.dsmserv script, which is provided for this purpose.

Before you begin

Ensure that access rights and user limits are set correctly. For instructions, see
[“Verifying access rights and user limits” on page 54.|

About this task

The rc.dsmserv script is in the server installation directory, for example, in the
/opt/tivoli/tsm/server/bin directory.

Procedure

If you did not use a wizard to configure the Tivoli Storage Manager server, add an
entry to the /etc/inittab file for each server that you want to automatically start:

1. Set the run level to the value that corresponds to multiuser mode with
networking enabled. Typically, the run level to use is 2, 3, or 5, depending on
the operating system and its configuration. Ensure that the run level in the
/etc/inittab file matches the run level of the operating system. For more
information about multiuser mode and run levels, see the documentation for
your operating system.

2. On the rc.dsmserv command, specify the instance user ID with the -u option,
and the location of the server instance directory with the -1 option. If you want
to start more than one server instance automatically, add an entry for each
server instance. To verify the syntax, see the documentation for your operating
system.
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Tip: To automatically start a server instance with the root user ID, use the -U
option.

Example

For example, if the instance owner is tsminstl and the server instance directory is
/home/tsminstl/tsminstl, add the following entry to /etc/inittab, on one line:

tsml:2:once:/opt/tivoli/tsm/server/bin/rc.dsmserv -u tsminstl
-i /home/tsminstl/tsminstl -q >/dev/console 2>&1

In this example, the ID for the process is tsml, and the run level is set to 2.

If you have more than one server instance that you want to run, add an entry for
each server instance. For example, if you have instance owner IDs tsminstl and
tsminst2, and instance directories /home/tsminst1l/tsminstl and
/home/tsminst2/tsminst2, add the following entries to /etc/inittab. Each entry is
on one line.
tsml:2:once:/opt/tivoli/tsm/server/bin/rc.dsmserv -u tsminstl

-i /home/tsminstl/tsminstl -q >/dev/console 2>&1

tsm2:2:once:/opt/tivoli/tsm/server/bin/rc.dsmserv -u tsminst2
-i /home/tsminst2/tsminst2 -q >/dev/console 2>&1

Tip: Optional: Use the Solaris Service Management Facility (SMF) to set up and
control Tivoli Storage Manager server instances. For more information, see
Technote 7021102 (http:/ /www.ibm.com/support/docview.wss?uid=swg27021102).

Stopping the server

You can stop the server when needed to return control to the operating system. To
avoid losing administrative and client node connections, stop the server only after
current sessions are completed or canceled.

About this task

To stop the server, issue the following command from the Tivoli Storage Manager
command line:

halt
The server console stops.
Remember: If you set up the Tivoli Storage Manager as a service by using the

Solaris Service Management Facility (SMF), stop the service by issuing the svcadm
disable command. For more information, see [Technote 7021102}

If you cannot connect to the server with an administrative client and you want to
stop the server, you must cancel the process by using the ki1l command with the
process ID number (pid) that is displayed at initialization.

Important: Before you issue the kill command, ensure that you know the correct
process ID for the Tivoli Storage Manager server.

The dsmserv.v6lock file, in the directory from which the server is running, can be
used to identify the process ID of the process to kill. To display the file enter:

cat /instance_dir/dsmserv.v6lock

Issue the following command to stop the server:
kill -16 dsmserv_pid
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where dsmserv_pid is the process ID number.

Registering licenses
Immediately register any Tivoli Storage Manager licensed functions that you
purchase so you do not lose any data after you start server operations, such as
backing up your data.
About this task
Use the REGISTER LICENSE command for this task.
Example: Register a license

Register the base Tivoli Storage Manager license.
register license file=tsmbasic.lic

Specifying a device class in preparation for database backups

To prepare the system for automatic and manual database backups, you must
specify the device class to be used.

Before you begin

Before you begin the setup, ensure that you have defined a tape or file device
class. See the defining device classes section of the Administrator’s Guide.

About this task

To set up your system for database backups, issue the SET DBRECOVERY command to
specify a device class to be used for the backups. You can also change the device
class to be used for database backups with the SET DBRECOVERY command.

Perform the following setup procedure:

Procedure

1. If you did not use the configuration wizard (dsmicfgx) to configure the server,
ensure that you have completed the steps to manually configure the system for
database backups.

2. Select the device class to be used for backups of the database. Issue the
following command from a IBM Tivoli Storage Manager administrative
command line.

set dbrecovery device_class_name

The device class that you specify is used by the database manager for database
backups. If you do not specify a device class with the SET DBRECOVERY
command, the backup fails.

Example

For example, to specify that the DBBACK device class is to be used, issue this
command:

set dbrecovery dbback
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What to do next

When you are ready to back up your database, see the BACKUP DB command in the
Administrator’s Reference.

Running multiple server instances on a single system

You can create more than one server instance on your system. Each server instance
has its own instance directory, and database and log directories.

Multiply the memory and other system requirements for one server by the number
of instances planned for the system.

The set of files for one instance of the server is stored separately from the files
used by another server instance on the same system. Use the steps in
erver instance” on page 44| for each new instance, including creation of the new
instance user.

To manage the system memory that is used by each server, use the DBMEMPERCENT
server option to limit the percentage of system memory. If all servers are equally
important, use the same value for each server. If one server is a production server
and other servers are test servers, set the value for the production server to a
higher value than the test servers.

When you upgrade from Tivoli Storage Manager V6.1, you must upgrade to V6.3
first, and then to V7.1. You can upgrade directly from either V6.2 or V6.3 to V7.1.
See the upgrade section (Chapter 5, “Upgrading to Tivoli Storage Manager Version|
[7.1,” on page 67) for more details. When you upgrade and have multiple servers
on your system, you must run the installation wizard only once. The installation
wizard collects the database and variables information for all of your original
server instances.

If you upgrade from Tivoli Storage Manager V6.2 or V6.3 to V7.1 and have
multiple servers on your system, all instances that exist in DB2 V9.7 are dropped
and recreated in DB2 V10.5. The wizard issues the db2 upgrade db dbname
command for each database. The database environment variables for each instance
on your system are also reconfigured during the upgrade process.

For information about the Server Initialization wizard, see the Tivoli Storage
Manager Administrator’s Guide.

Monitoring the server

When you start using server in production operation, monitor the space used by
the server to ensure that the amount of space is adequate. Make adjustments as
needed.

Procedure

1. Monitor the active log, to ensure that the size is correct for the workload that is
handled by the server instance.

When the server workload is up to its typical expected level, and the space that
is used by the active log is 80 - 90% of the space that is available to the active
log directory, you might need to increase the amount of space. Whether you
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need to increase the space depends on the types of transactions in the server's
workload, because transaction characteristics affect how the active log space is
used.

The following transaction characteristics can affect the space usage in the active
log:
* The number and size of files in backup operations

— Clients such as file servers that back up large numbers of small files can
cause large numbers of transactions that complete during a short period of
time. The transactions might use a large amount of space in the active log,
but for a short period of time.

— Clients such as a mail server or a database server that back up large
chunks of data in few transactions can cause small numbers of
transactions that take a long time to complete. The transactions might use
a small amount of space in the active log, but for a long period of time.

* Network connection types

— Backup operations that occur over fast network connections cause
transactions that complete more quickly. The transactions use space in the
active log for a shorter period of time.

— Backup operations that occur over relatively slower connections cause
transactions that take a longer time to complete. The transactions use
space in the active log for a longer period of time.

If the server is handling transactions with a wide variety of characteristics, the
space that is used for the active log might go up and down by a large amount
over time. For such a server, you might need to ensure that the active log
typically has a smaller percentage of its space used. The extra space allows the
active log to grow for transactions that take a very long time to complete, for
example.

Monitor the archive log to ensure that space is always available.

Remember: If the archive log becomes full, and the failover archive log
becomes full, the active log can become full and the server will stop. The goal
is to make enough space available to the archive log so that it never uses all its
available space.

You are likely to notice the following pattern:

a. Initially, the archive log grows rapidly as typical client-backup operations
occur.

Database backups occur regularly, either as scheduled or done manually.

After at least two full database backups occur, log pruning occurs
automatically. The space used by the archive log decreases when the
pruning occurs.

Normal client operations continue, and the archive log grows again.

Database backups occur regularly, and log pruning occurs as often as full
database backups occur.
With this pattern, the archive log grows initially, then decreases, then might
grow again. Over a period of time, as normal operations continue, the amount
of space used by the archive log should reach a relatively constant level.

If the archive log continues to grow, consider taking one or both of these
actions:

¢ Add space to the archive log. This might mean moving the archive log to a
different file system.
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For information about moving the archive log, see the Tivoli Storage Manager
Administrator’s Guide.

¢ Increase the frequency of full database backups, so that log pruning occurs
more frequently.

3. If you defined a directory for the failover archive log, determine whether any
logs get stored in that directory during normal operations. If the failover log
space is being used, consider increasing the size of the archive log. The goal is
that the failover archive log is used only under unusual conditions, not in
normal operation.

What to do next

For details about monitoring, see the Administrator’s Guide.
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Chapter 4. Installing a Tivoli Storage Manager server fix pack

Tivoli Storage Manager maintenance updates, which are also referred to as fix
packs, bring your server up to the current maintenance level.

Before you begin

To install a fix pack or interim fix to the server, install the server at the level on
which you want to run it. You do not have to start the server installation at the
base release level. For example, if you currently have Version 6.3.4.2 installed, you
can go directly to the latest fix pack for V7.1. You do not have to start with the
V7.1.0 installation if a maintenance update is available.

You must have the Tivoli Storage Manager license package installed. The license
package is provided with the purchase of a base release. Alternatively, you can
obtain the license package when download a fix pack from the Passport Advantage
website. After the fix pack or interim fix is installed, install the license for the
server. To display messages and help in a language other than US English, install
the language package of your choice.

For information about the estimated time required to install a fix pack, see
023591

If you upgrade the server to V7.1 or later, and then revert the server to a level that
is earlier than V7.1, you must restore the database to a point in time before the
upgrade. During the upgrade process, complete the required steps to ensure that
the database can be restored: back up the database, the volume history file, the
device configuration file, and the server options file. For more information, see
(Chapter 6, “Reverting from Version 7.1 to the previous V6 server,” on page 77

Ensure that you retain the installation media from the base release of the installed
server. If you installed Tivoli Storage Manager from a DVD, ensure that the DVD is
available. If you installed Tivoli Storage Manager from a downloaded package,
ensure that the downloaded files are available. If the upgrade fails, and the server
license module is uninstalled, the installation media from the server base release
are required to reinstall the license.

Visit this website: |http:/ /www.ibm.com /support/entry /portal /Overview /|
Software /Tivoli/Tivoli_Storage_Manager for the following information:

* A list of the latest maintenance and download fixes. Click Support and
downloads and apply any applicable fixes.

* Details about obtaining a base license package. Search for Warranties and
licenses.

* Supported platforms and system requirements. Click Server requirements.
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About this task

To install a fix pack or interim fix, complete the following steps.

Attention: Do not alter the DB2 software that is installed with Tivoli Storage
Manager installation packages and fix packs. Do not install or upgrade to a
different version, release, or fix pack of DB2 software because doing so can damage
the database.

Procedure
1. Log in as the root user.

2. Obtain the package file for the fix pack or interim fix that you want to install
from the |http://www.ibm.com /support/entry /portal /Overview /Software/|
[Tivoli/Tivoli_Storage_Manager site.

3. Change to the directory where you placed the executable file and complete the
following steps.

Tip: The files are extracted to the current directory. Ensure that the executable
file is in the directory where you want the extracted files to be located.

a. Change file permissions by entering the following command:
chmod a+x 6.x.x.x-TIV-TSMALL-platform.bin

where platform denotes the architecture that Tivoli Storage Manager is to
be installed on.

b. Issue the following command to extract the installation files:
./6.x.X.x-TIV-TSMALL-platform.bin

4. Back up the database. The preferred method is to use a snapshot backup. A
snapshot backup is a full database backup that does not interrupt any
scheduled database backups. For example, issue the following Tivoli Storage
Manager administrative command:

backup db type=dbsnapshot devclass=tapeclass

See the Administrator’s Guide for more details.

5. Back up the device configuration information. Issue the following Tivoli
Storage Manager administrative command:

backup devconfig filenames=file_name

where file_name specifies the name of the file in which to store device
configuration information.

6. Save the volume history file to another directory or rename the file. Issue the
following Tivoli Storage Manager administrative command:

backup volhistory filenames=file_name

where file_name specifies the name of the file in which to store the volume
history information.

7. Save a copy of the server options file, typically named dsmserv.opt. The file is
in the server instance directory.

8. Halt the server before installing a fix pack or interim fix. Use the HALT
command.

9. Ensure that extra space is available in the installation directory. The
installation of this fix pack might require additional temporary disk space in
the installation directory of the server. The amount of additional disk space
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can be as much as that required for installing a new database as part of a
Tivoli Storage Manager installation. The Tivoli Storage Manager installation
wizard displays the amount of space that is required for installing the fix pack
and the available amount. If the required amount of space is greater than the
available amount, the installation stops. If the installation stops, add the
required disk space to the file system and restart the installation.

10. Select one of the following ways of installing Tivoli Storage Manager.

Important: After a fix pack is installed, it is not necessary to go through the
configuration again. You can stop after completing the installation, fix any
errors, then restart your servers.

Install the Tivoli Storage Manager software by using one of the following
methods:

Installation wizard
Follow the instructions for your operating system:

“Installing Tivoli Storage Manager by using the installation wizard”]

on page 33|

Tip: After you start the wizard, in the IBM Installation Manager window,
click the Update icon; do not click the Install or Modify icon.

Command line in console mode
Follow the instructions for your operating system:

[“Installing Tivoli Storage Manager by using console mode” on page 34

Silent mode
Follow the instructions for your operating system:

[“Installing Tivoli Storage Manager in silent mode” on page 35|

Tip: If you have multiple server instances on your system, run the installation
wizard only once. The installation wizard upgrades all server instances.

Results

If errors occur during the installation process, these errors are recorded in log files
that are stored in the IBM Installation Manager logs directory.

You can view installation log files by clicking File > View Log from the Installation

Manager tool. To collect these log files, click Help > Export Data for Problem
Analysis from the Installation Manager tool.
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Chapter 5. Upgrading to Tivoli Storage Manager Version 7.1

You can upgrade a Tivoli Storage Manager V5 or V6 server to V7.1. If a V5 server
is installed on an AIX, HP-UX, Solaris, or z/OS® operating system, you can
complete a cross-platform migration to V7.1 on a different operating system.

About this task

To upgrade the server on the same operating system, see the upgrade instructions:

Table 16. Upgrade information

To upgrade from this

version To this version See this information

V7.1 V7.1 fix pack or interim fix Chapter 4, “Installing a Tivoli|
Storage Manager server fixI
back,” on page 63|

V6.2 or V6.3 V7.1 “Uperading from Tivoli
Storage Manager V6.2 or
V6.3 to V7.1” on page 68|

V6.1 V7.1 “Upgrading from Tivoli
Storage Manager V6.1 to|
V7.1” on page 76|

V5.5 V7.1 Upgrade and Migration Guide
for V5 Servers

If a Tivoli Storage Manager V5 server is installed, and you prefer to upgrade the
server to V7 on a different operating system, see the instructions for server

migration:

Table 17. Migration information

To migrate the server from
this operating system

To this operating system

See this information

AIX

Linux x86_64

Section about migrating
Tivoli Storage Manager V5
servers on AIX, HP-UX, or
Solaris systems to V7.1 on
Linux in the Upgrade and
Migration Guide for V5 Servers

HP-UX

Linux x86_64

Section about migrating
Tivoli Storage Manager V5
servers on AIX, HP-UX, or
Solaris systems to V7.1 on
Linux in the Upgrade and
Migration Guide for V5 Servers

Solaris

Linux x86_64

Section about migrating
Tivoli Storage Manager V5
servers on AIX, HP-UX, or
Solaris systems to V7.1 on
Linux in the Upgrade and
Migration Guide for V5 Servers

© Copyright IBM Corp. 1993, 2013

67



Upgrading the Tivoli Storage Manager server

Table 17. Migration information (continued)

To migrate the server from
this operating system To this operating system See this information

z/0S AIX Section about migrating
Tivoli Storage Manager V5
servers on z/OS systems to
V7 on AIX or Linux on
System z° in the Upgrade and
Migration Guide for V5 Servers

z/0S Linux on System z Section about migrating
Tivoli Storage Manager V5
servers on z/0OS systems to
V7 on AIX or Linux on
System z in the Upgrade and
Migration Guide for V5 Servers

To revert to an earlier version of Tivoli Storage Manager after an upgrade or
migration, you must have a full database backup and the installation software for
the original server. You must also have key configuration files:

* Volume history file

* Device configuration file

* Server options file

* dsmserv.dsk file (for a server upgrade or migration from V5 to V7.1)

Upgrading from Tivoli Storage Manager V6.2 or V6.3 to V7.1
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You can upgrade the server directly from Tivoli Storage Manager V6.2 or V6.3 to
V7.1. You do not need to uninstall V6.2 or V6.3.

Before you begin

Ensure that you retain the installation media from the V6.2 or V6.3 server base
release that you are upgrading. If you installed Tivoli Storage Manager from a
DVD, ensure that the DVD is available. If you installed Tivoli Storage Manager
from a downloaded package, ensure that the downloaded files are available. If the
upgrade fails, and the server license module is uninstalled, the installation media
from the server base release are required to reinstall the license.

Procedure

To upgrade the server to V7.1, complete the following tasks:

1. |“Planning the upgrade” on page 69|

2. [“Preparing the system” on page 70|

3. |“Installing the V7.1 server and verifying the upgrade” on page 72|
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Planning the upgrade

Before you upgrade the server from V6.2 or V6.3 to V7.1, you must review the
relevant planning information, such as system requirements and release notes.
Then, select an appropriate day and time to upgrade the system so that you can
minimize the impact on production operations.

About this task

In lab tests, the process of upgrading the server from V6.2 or V6.3 to V7.1 took 14 -
45 minutes. The results that you achieve might differ, depending on your hardware
and software environment, and the size of the server database.

The following table shows the results that were obtained in lab tests.

Table 18. V6 to V7 upgrade times in lab tests

Version of Random

source Version of Operating Size of server | access

system target system |system database memory Upgrade time
V6.3.4 V7.1 AIX 17 GB 64 GB 40 minutes
V6.3.4 V7.1 AIX 487 GB 32 GB 45 minutes
V6.3.4 V7.1 AIX 3.8 TB 64 GB 35 minutes
V6.2.5 V7.1 Linux 6.16 GB 16 GB 15 minutes
Ve6.3.4 V7.1 Linux 30 GB 16 GB 14 minutes
V6.2.5 V7.1 Linux 70 GB 16 GB 24 minutes
V6.3.4 V7.1 Linux 1.4 TB 64 GB 30 minutes
V6.2.5 V7.1 Solaris 9.43 GB 32 GB 35 minutes
V6.3.4 V7.1 Windows 2.35TB 64 GB 45 minutes
Procedure

1. Review the hardware and software requirements:

[“System requirements for the Tivoli Storage Manager server” on page 4|

For the latest updates related to system requirements, see the Tivoli Storage
Manager support website at |http://www.ibm.com/support/|
[docview.wss?uid=swe21243309]

2. For special instructions or specific information for your operating system,
review the release notes: |http:/ /publib.boulder.ibm.com /infocenter/tsminfo /|
[v7r1 /topic/com.ibm.itsm.nav.doc/r_relnotes.html]

3. If the server that you are upgrading is at a release level that is earlier than
V6.2.3.000, review Technote 1452146 (http://www.ibm.com/support/|
[docview.wss?uid=swg21452146). The technote describes improvements in the
database reorganization process, and configuration changes that you might be
required to make.

4. Select an appropriate day and time to upgrade your system to minimize the
impact on production operations. The amount of time that is required to
update the system depends on the database size and many other factors. When
you start the upgrade process, clients cannot connect to the server until the
new software is installed and any required licenses are registered again.
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Preparing the system

To prepare the system for the upgrade from V6.2 or V6.3 to V7.1, you must gather
information about each DB2 instance. Then, back up the server database, save key
configuration files, cancel sessions, and stop the server.

Procedure
1. Log on to the computer where Tivoli Storage Manager is installed.
Ensure that you are logged on with the instance user ID.
2. Obtain a list of DB2 instances. Issue the following system command:
/opt/tivoli/tsm/db2/instance/db2ilist

The output might be similar to the following example:
tsminstl

Ensure that each instance corresponds to a server that is running on the
system.

3. For each DB2 instance, note the default database path, actual database path,
database name, database alias, and any DB2 variables that are configured for
the instance. Keep the record for future reference. This information is required
to restore the V6 database.

a. Obtain the default database path of the DB2 instance by issuing the
following system command:

. ~/sqllib/db2profile; LC_ALL=C db2 get dbm cfg | grep DFTDBPATH

The output might be similar to the following example:
Default database path (DFTDBPATH) = /tsminstl/tsminstl

Tip: If you are upgrading the server from V6.3, the default database path
is /tsminst1l/tsminstl. If you are upgrading the server from V6.2, the
default database path is /home/tsminst1/tsminstl.

b. Obtain information about the DB2 instance databases by issuing the
following system command:

. ~/sq11ib/db2profile; LC_ALL=C db2 Tist database directory

The output might be similar to the following example:
System Database Directory

Number of entries in the directory = 2

Database 1 entry:

Database alias = TSMALOO1

Database name = TSMDB1

Node name = TSMNODE1

Database release level = d.00

Comment = TSM SERVER DATABASE VIA TCPIP
Directory entry type = Remote

Catalog database partition number = -1

Alternate server hostname =

Alternate server port number =
Database 2 entry:

Database alias = TSMDB1

Database name = TSMDB1

Local database directory = /tsminstl/tsminstl
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Alternate server hostname
Alternate server port number

Database release level = d.00

Comment = TSM SERVER DATABASE
Directory entry type = Indirect

Catalog database partition number =0

c. Obtain the DB2 instance variables by issuing the following system
command:

. ~/sq11ib/db2profile; LC_ALL=C db2set -all

The output might be similar to the following example:

[i] DB2_PMODEL_SETTINGS=MAX_BACKGROUND_ SYSAPPS:500
[i] DB2_SKIPINSERTED=ON

[i] DB2_KEEPTABLELOCK=0FF

[i] DB2_EVALUNCOMMITTED=ON

[1] DB2_SKIPDELETED=0ON

[i] DB2COMM=TCPIP

[i] DB2CODEPAGE=819

[i] DB2_PARALLEL_I0=+

[g] DB2FCMCOMM=TCPIP6

[g] DB2SYSTEM=freeride.storage.tucson.ibm.com
[g] DB2INSTDEF=tsminstlinst

d. Obtain more DB2 instance information by saving the following files:
~/sq11ib/userprofile
~/sqllib/usercshrc

For example, issue the following system commands:
cp ~/sqllib/userprofile copy location
cp ~/sqllib/usercshrc copy location

where copy_location is the location where the copied file is saved.
The file content might be similar to the following example:

setenv DSMI_CONFIG /tsminstl/tsminstl/tsmdbmgr.opt

setenv DSMI_DIR /opt/tivoli/tsm/client/bin64

setenv DSMI_LOG /tsminstl/tsminstl

setenv LD_LIBRARY_PATH /usr/Tocal/ibm/gsk8 64/1ib64:$LD_LIBRARY_PATH
Connect to the Tivoli Storage Manager server by using an administrative user
ID.

Back up the Tivoli Storage Manager database. For example, you can create a
snapshot backup by issuing the following Tivoli Storage Manager
administrative command:

backup db type=dbsnapshot devclass=tapeclass

A snapshot backup is a full database backup that does not interrupt any
scheduled database backups. For more information about this command and
other Tivoli Storage Manager administrative commands, see the
Administrator’s Reference.

Back up the device configuration information to another directory by issuing
the following Tivoli Storage Manager administrative command:

backup devconfig filenames=file_name

where file_name specifies the name of the file in which to store device
configuration information.

Tip: If you decide to restore the V6 database, this file is required.
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7. Back up the volume history file to another directory. Issue the following Tivoli
Storage Manager administrative command:

backup volhistory filenames=file name

where file_name specifies the name of the file in which to store the volume
history information.

Tip: If you decide to restore the V6 database, this file is required.

8. Save a copy of the server options file, which is typically named dsmserv.opt.
The file is in the server instance directory.

9. Prevent activity on the server by disabling new sessions. Issue the following
Tivoli Storage Manager administrative commands:

disable sessions client
disable sessions server

10. Verify whether any sessions exist, and notify the users that the server will be
stopped. To check for existing sessions, issue the following Tivoli Storage
Manager administrative command:

query session

11. Cancel sessions by issuing the following Tivoli Storage Manager
administrative command:

cancel session all

This command cancels all sessions except for your current session.

12. Stop the server by issuing the following Tivoli Storage Manager
administrative command:

halt

13. Verify that the server is shut down and no processes are running.
Issue the following command:
ps -ef | grep dsmserv

14. In the server instance directory of your installation, locate the NODELOCK file
and move it to another directory, where you are saving configuration files.
The NODELOCK file contains the previous licensing information for your
installation. This licensing information is replaced when the upgrade is
complete.

Installing the V7.1 server and verifying the upgrade

To complete the process of upgrading the server from V6.2 or V6.3 to V7.1, you
must install the V7.1 server. Then, verify that the upgrade was successful by
starting the server instance.

Before you begin
You must be logged on to the system by using the root user ID.

You can obtain the installation package from the product DVD or from an IBM
download site.

If you plan to download the files, set the system user limit for maximum file size
to unlimited to ensure that the files can be downloaded correctly.

1. To query the maximum file size value, issue the following command:
ulimit -Hf
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2. If the system user limit for maximum file size is not set to unlimited, change it

to unlimited by following the instructions in the documentation for your
operating system.

About this task

By using the Tivoli Storage Manager installation software, you can install the
following components:

Tivoli Storage Manager server

Tivoli Storage Manager server languages
Tivoli Storage Manager license

Tivoli Storage Manager devices

Tivoli Storage Manager Operations Center
Tivoli Storage Manager storage agent

Tip: The database (DB2) and the Global Security Kit are automatically installed
when you select the server component.

For more information about storage agents, see the Storage Agent User’s Guide.

Procedure

1. If you are obtaining the package from an IBM download site, download the
appropriate package file from one of the following websites:

¢ For a new release, go to Passport Advantage at [http:/ / www.ibm.com /|
ksoftware /lotus/passportadvantage /| Passport Advantage is the only
website from which you can download a licensed package file.

» For a maintenance fix, go to the Tivoli Storage Manager support site at
http:/ /www.ibm.com /support/entry /portal /Overview /Software / Tivoli /|
Tivoli_Storage Manager|

2. If you are downloading the package from one of the download sites, complete
the following steps:

a. Verify that you have enough space to store the installation files
when they are extracted from the product package. For space
requirements, see the download document for your product:

« Tivoli Storage Manager: |http: / /www.ibm.com /support/|
[docview.wss?uid=swg24035122|

» Tivoli Storage Manager Extended Edition: |http: // |
[www.ibm.com /support/docview.wss?uid=swg24035635|

« System Storage Archive Manager: |http:// www.ibm.com/l
[support/docview.wss?uid=swg24035637|

b. Download the package file to the directory of your choice. The
path must contain no more than 128 characters. Be sure to extract
the installation files to an empty directory. Do not extract to a
directory that contains previously extracted files, or any other files.

Also, ensure that you have executable permission for the package
file.

C. If necessary, change the file permissions by issuing the following
command:

chmod a+x package_name.bin

where package_name is like the following example:
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7.1.0.000-TIV-TSMSRV-SoTarisSPARC.bin

In the examples, 7.1.0.000 represents the product release level.
d. Extract the installation files by issuing the following command:
./package_name .bin

The package is large. Therefore, the extraction takes some time.

3. To ensure that the Tivoli Storage Manager wizards work correctly, verify that

the following command is enabled:
logins

By default, the command is enabled.

Install the Tivoli Storage Manager software by using one of the following
methods. During the installation process, you must install the Tivoli Storage
Manager license.

Installation wizard
To install the server by using the graphical wizard of IBM Installation
Manager, follow the instructions in [“Installing Tivoli Storage Managei]
[by using the installation wizard” on page 33 Ensure that your system
meets the prerequisites for using the installation wizard. Then,
complete the installation procedure. In the IBM Installation Manager
window, click the Install icon; do not click the Update or Modify
icon.

Tip: If you have multiple server instances on your system, run the
installation wizard only once. The installation wizard upgrades all
server instances.

Command line in console mode

To install the server by using the command line in console mode,
follow the instructions in [“Installing Tivoli Storage Manager by using]|
fconsole mode” on page 34/

Review the information about installing the server in console mode
and then complete the installation procedure.

Silent mode
To install the server in silent mode, follow the instructions in
[‘Installing Tivoli Storage Manager in silent mode” on page 35| Review
the information about installing the server in silent mode. Then,
complete Steps 1 and 2 of the installation procedure.

Correct any errors that are detected during the installation process. To view
installation log files, from the Installation Manager tool, click File > View Log.
To collect log files, from the Installation Manager tool, click Help > Export
Data for Problem Analysis.

Obtain any applicable fixes by going to the following website:

http:/ /www.ibm.com /support/entry/portal/Overview /Software/ Tivoli/ |

Tivoli_Storage Manager] Click Fixes (downloads) and apply any applicable

fixes.

7. Verify that the upgrade was successful:

a. Start the server instance. For instructions, see [‘Starting the server instance’|

b. Monitor the messages that the server issues as it starts. Watch for error
and warning messages, and resolve any issues.
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C. Verify that you can connect to the server by using the administrative client.
To start an administrative client session, issue the following Tivoli Storage
Manager administrative command:

dsmadmc

d. To obtain information about the upgraded system, run QUERY commands.
For example, to obtain consolidated information about the system, issue
the following Tivoli Storage Manager administrative command:

query system

To obtain information about the database, issue the following Tivoli
Storage Manager administrative command:

query db format=detailed

Register the licenses for the Tivoli Storage Manager server components that
are installed on your system by issuing the REGISTER LICENSE command:

register license file=installation_directory/server/bin/component_name.lic

where installation_directory specifies the directory in which you installed the
component, and component_name specifies the abbreviation for the component.

For example, if you installed the server in the default directory,
/opt/tivoli/tsm, register the license by issuing the following command:

register license file=/opt/tivoli/tsm/server/bin/tsmbasic.lic

For example, if you installed Tivoli Storage Manager Extended Edition in the
/opt/tivoli/tsm directory, issue the following command:

register license file=/opt/tivoli/tsm/server/bin/tsmee.lic

For example, if you installed System Storage Archive Manager in the
/opt/tivoli/tsm directory, issue the following command:

register license file=/opt/tivoli/tsm/server/bin/dataret.lic

Restriction: You cannot register licenses for Tivoli Storage Manager for Mail,
Tivoli Storage Manager for Databases, Tivoli Storage Manager for ERP, and
Tivoli Storage Manager for Space Management.

Optional: To install an additional language package, use the modify function
of the IBM Installation Manager.

Optional: To upgrade to a newer version of a language package, use the
update function of the IBM Installation Manager.

What to do next

You can authenticate passwords with the LDAP directory server, or authenticate
passwords with the Tivoli Storage Manager server. Passwords that are
authenticated with the LDAP directory server can provide enhanced system
security. For instructions, see the section about managing passwords and logon
procedures in the Administrator’s Guide.
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You can upgrade the Tivoli Storage Manager server from V6.1 to V6.3, and then
upgrade the server to V7.1. It is not possible to upgrade the server directly from
V6.1 to V7.1

Before you begin

Ensure that you retain the installation media from the base release of the V6.1 and
V6.3 servers. If you obtained the Tivoli Storage Manager software from a DVD,
ensure that the DVD is available. If you obtained the Tivoli Storage Manager
software from a downloaded package, ensure that the downloaded files are
available. If the upgrade fails, and the server license module is uninstalled, the
installation media from the server base release are required to reinstall the license.

Procedure

1. Upgrade the server from V6.1 to V6.3. For instructions, go to the Tivoli Storage
Manager V6.3 Information Center at |http://pic.dhe.ibm.com/infocenter /|
tsminfo/v6r3} Follow the instructions for upgrading the server from V6.1 to
V6.3 or later.

2. Upgrade the server from V6.3 to V7.1, as described in|“Upgrading from Tivoli
[Storage Manager V6.2 or V6.3 to V7.1” on page 68
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Chapter 6. Reverting from Version 7.1 to the previous V6
server

If you must revert to the previous version of the server after an upgrade, you must
have a full database backup from your original version. You must also have the
server installation media for your original version and key configuration files.
Carefully follow the preparation steps before you upgrade the server. By doing so,
it might be possible to revert to the previous version of the Tivoli Storage Manager
server with minimal loss of data.

Before you begin

You must have the following items from the earlier version of the server:
* Server database backup

* Volume history file

* Device configuration file

* Server options file
About this task

Use the same instructions whether you are reverting within releases or to an earlier
release, for example, from 6.2.2 to 6.2.0 or from 6.2.2 to 6.1.2. The older version
must match the version that you used before the upgrade to 7.1.

Attention: Specify the REUSEDELAY parameter to help prevent backup-archive
client data loss when you revert the server to a previous version.

Steps for reverting to the previous server version
About this task

Complete the following steps on the system that has the V7.1 server.

Procedure
1. Halt the server to shut down all server operations by using the HALT
command.

2. Remove the database from the database manager, then delete the database and
recovery log directories.
a. Manually remove the database. One way to remove it is by issuing this
command:
dsmserv removedb tsmdbl

b. If you must reuse the space that is occupied by the database and recovery
log directories, you can now delete these directories.

3. Use the uninstallation program to uninstall the V7.1 server. Uninstallation
removes the server and the database manager, with their directories. For
details, see [Chapter 8, “Uninstalling Tivoli Storage Manager,” on page 85/

4. Reinstall the version of the server program that you were using before the
upgrade to V7.1. This version must match the version that your server was
running when you created the database backup that you restore in a later
step. For example, the server was at version 6.2.2.0 before the upgrade, and
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you intend to use the database backup that was in use on this server. You
must install the 6.2.2.0 fix pack to be able to restore the database backup.

5. Copy the following files to the instance directory.
* Device configuration file
* Volume history file
* The server options file (typically dsmserv.opt)

6. Configure the new server database by using the configuration wizard. To start
the wizard, issue the following command:

. /dsmicfgx
7. Ensure that no servers are running in the background.

8. Restore the database to a point in time before the upgrade. For more details,
see the restoring the server database to a point in time section in the
Administrator’s Guide.

9. If you enabled data deduplication for any FILE-type storage pools that existed
before the upgrade, or if you moved data that existed before the upgrade into
new storage pools while using the V7.1 server, you must complete additional
recovery steps. For more details, see|“Additional recovery steps if you created|
[new storage pools or enabled data deduplication.”

10. If the REUSEDELAY parameter setting on storage pools is less than the age of the
database that you restored, restore volumes on any sequential-access storage
pools that were reclaimed after that database backup. Use the RESTORE VOLUME
command.

If you do not have a backup of a storage pool, audit the reclaimed volumes
by using the AUDIT VOLUME command, with the FIX=YES parameter to resolve
inconsistencies. For example:

audit volume volume_name fix=yes

11. If client backup or archive operations were completed using the V7.1 server,
audit the storage pool volumes on which the data was stored.

Additional recovery steps if you created new storage pools or enabled
data deduplication

78

If you created new storage pools, turned on data deduplication for any FILE-type
storage pools, or did both while your server was running as a V7.1 server, you
must complete more steps to return to the previous server version.

Before you begin

To complete this task, you must have a complete backup of the storage pool that
was created before the upgrade to V7.1.

About this task

Use this information if you did either or both of the following actions while your
server was running as a V7.1 server:

* You enabled the data deduplication function for any storage pools that existed
before the upgrade to V7.1 program. Data deduplication applies only to storage
pools that use a FILE device type.

* You created new, primary storage pools after the upgrade, and moved data that
was stored in other storage pools into the new storage pools.

Complete these steps after the server is again restored to V6.
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Procedure

* For each storage pool for which you enabled the data deduplication function,
restore the entire storage pool by using the RESTORE STGPOOL command.

* For storage pools that you created after the upgrade, determine what action to
take. Data that was moved from existing, V6 storage pools into the new storage
pools might be lost because the new storage pools no longer exist in your
restored V6 server. Possible recovery depends on the type of storage pool:

— If data was moved from V6 DISK-type storage pools into a new storage pool,
space that was occupied by the data that was moved was probably reused.
Therefore, you must restore the original, V6 storage pools, by using the
storage pool backups that were created before the upgrade to V7.1.

If no data was moved from V6 DISK-type storage pools into a new storage
pool, then audit the storage pool volumes in these DISK-type storage pools.

— If data was moved from V6 sequential-access storage pools into a new storage
pool, that data might still exist and be usable in storage pool volumes on the
restored V6 server. The data might be usable if the REUSEDELAY parameter for
the storage pool was set to a value that prevented reclamation while the
server was running as a V7.1 server. If any volumes were reclaimed while the
server was running as a V7.1 server, restore those volumes from storage pool
backups that were created before the upgrade to V7.1.
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Chapter 7. Reference: DB2 commands for Tivoli Storage
Manager server databases

Use this list as reference when you are directed to issue DB2 commands by IBM

support.

Purpose

After using the wizards to install and configure Tivoli Storage Manager, you
seldom need to issue DB2 commands. A limited set of DB2 commands that you
might use or be asked to issue are listed in This list is supplemental
material only and is not a comprehensive list. There is no implication that a Tivoli
Storage Manager administrator will use it on a daily or ongoing basis. Samples of
some commands are provided. Details of output are not listed.

For a full explanation of the commands described here and of their syntax, see

http: / /pic.dhe.ibm.com/infocenter/db2luw /v10r5|

Table 19. DB2 commands

Command Description Example
db2icrt Creates DB2 instances in the home Manually create a Tivoli Storage Manager
directory of the instance owner. instance. Enter the command on one line:
Tip: The Tivoli Storage Manager Jopt/tivoli/tsm/db2/instance/
configuration wizard creates the instance | dh2icrt -a server -s ese -u
used by the server and database. After a instance name instance name
server is installed and configured through - -
the configuration wizard, the db2icrt
command is generally not used.
This utility is in the DB2DIR/instance
directory, where DB2DIR represents the
installation location where the current
version of the DB2 database system is
installed.
db2osconf Checks the settings of the kernel Retrieve a list of currently supported
configuration parameters and suggests options:
updates to improve performance. The db2osconf
suggested updates provided by the
db2osconf utility are the minimum
settings required to run DB2 on your
system.
db2set Displays DB2 variables. List DB2 variables:

db2set

CATALOG DATABASE

Stores database location information in the
system database directory. The database
can be located either on the local
workstation or on a remote database
partition server. The server configuration
wizard takes care of any catalog needed
for using the server database. Run this
command manually, after a server is
configured and running, only if something
in the environment changes or is
damaged.

Catalog the database:
db2 catalog database tsmdbl

CONNECT TO DATABASE

Connects to a specified database for
command-line interface (CLI) use.

Connect to the Tivoli Storage Manager
database from a DB2 CLI:

db2 connect to tsmdbl
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Table 19. DB2 commands (continued)

Command

Description

Example

GET DATABASE CONFIGURATION

Returns the values of individual entries in
a specific database configuration file.
Important: This command and
parameters are set and managed directly
by DB2. They are listed here for
informational purposes and a means to
view the existing settings. Changing these
settings might be advised by IBM support
or through service bulletins such as
APARs or Technical Guidance documents
(technotes). Do not change these settings
manually. Change them only at the
direction of IBM and only through the use
of Tivoli Storage Manager server
commands or procedures.

Show the configuration information for a
database alias:

db2 get db cfg for tsmdbl

Retrieve information in order to verify
settings such as database configuration,
log mode, and maintenance.

db2 get db config for tsmdbl
show detail

GET DATABASE MANAGER CONFIGURATION

Returns the values of individual entries in
a specific database configuration file.
Important: This command and
parameters are set and managed directly
by DB2. They are listed here for
informational purposes and a means to
view the existing settings. Changing these
settings might be advised by IBM support
or through service bulletins such as
APARs or Technical Guidance documents
(technotes). Do not change these settings
manually. Change them only at the
direction of IBM and only through the use
of Tivoli Storage Manager server
commands or procedures.

Retrieve configuration information for the
database manager:

db2 get dbm cfg

GET HEALTH SNAPSHOT

Retrieves the health status information for
the database manager and its databases.
The information returned represents a
snapshot of the health state at the time
the command was issued. Tivoli Storage
Manager monitors the state of the
database using the health snapshot and
other mechanisms that are provided by
DB2. There might be cases where the
health snapshot or other DB2
documentation indicates that an item or
database resource might be in an alert
state. Such a case indicates that action
must be considered to remedy the
situation. Tivoli Storage Manager monitors
the condition and responds appropriately.
Not all declared alerts by the DB2
database are acted on.

Receive a report on DB2 health monitor
indicators:

db2 get health snapshot for
database on tsmdbl

GRANT (Database Authorities)

Grants authorities that apply to the entire
database rather than privileges that apply
to specific objects within the database.

Grant access to the user ID itmuser:

db2 GRANT CONNECT ON DATABASE
TO USER itmuser

db2 GRANT CREATETAB ON DATABASE
TO USER itmuser
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Table 19. DB2 commands (continued)

Command

Description

Example

RUNSTATS

Updates statistics about the characteristics
of a table and associated indexes or
statistical views. These characteristics
include number of records, number of
pages, and average record length.

To see a table, issue this utility after
updating or reorganizing the table.

A view must be enabled for optimization
before its statistics can be used to
optimize a query. A view that is enabled
for optimization is known as a statistical
view. Use the DB2 ALTER VIEW statement
to enable a view for optimization. Issue
the RUNSTATS utility when changes to
underlying tables substantially affect the
rows returned by the view.

Tip: The server configures DB2 to run the
RUNSTATS command as needed.

Update statistics on a single table.

db2 runstats on table
SCHEMA_NAME.TABLE_NAME

with distribution and sampled
detailed indexes all

SET SCHEMA

Changes the value of the CURRENT SCHEMA
special register, in preparation for issuing
SQL commands directly through the DB2
CLL

Tip: A special register is a storage area
that is defined for an application process
by the database manager. It is used to
store information that can be referenced in
SQL statements.

Set the schema for Tivoli Storage
Manager:

db2 set schema tsmdbl

START DATABASE MANAGER

Starts the current database manager
instance background processes. The Tivoli
Storage Manager server starts and stops
the instance and database whenever the
server starts and halts.

Important: Allow the Tivoli Storage
Manager server to manage the starting
and stopping of the instance and database
unless otherwise directed by IBM support.

Start the database manager:
db2start

STOP DATABASE MANAGER

Stops the current database manager
instance. Unless explicitly stopped, the
database manager continues to be active.
This command does not stop the database
manager instance if any applications are
connected to databases. If there are no
database connections, but there are
instance attachments, the command forces
the instance attachments to stop first.
Then, it stops the database manager. This
command also deactivates any
outstanding database activations before
stopping the database manager.

This command is not valid on a client.

The Tivoli Storage Manager server starts
and stops the instance and database
whenever the server starts and halts.
Important: Allow the Tivoli Storage
Manager server to manage the starting
and stopping of the instance and database
unless otherwise directed by IBM support.

Stop the database manager:
db2 stop dbm
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Chapter 8. Uninstalling Tivoli Storage Manager

You can use the following procedures to uninstall Tivoli Storage Manager. Before
you remove Tivoli Storage Manager, ensure that you do not lose your backup and
archive data.

Before you begin

Complete the following steps before you uninstall Tivoli Storage Manager:

* Complete a full database backup.

* Save a copy of the volume history and device configuration files.

* Store the output volumes in a safe location.

About this task

You can uninstall Tivoli Storage Manager by using any of the following methods: a
graphical wizard, the command line in console mode, or silent mode.

[“Uninstalling Tivoli Storage Manager by using a graphical wizard”]

[“Uninstalling Tivoli Storage Manager in console mode” on page 86|

[“Uninstalling Tivoli Storage Manager in silent mode” on page 86|

What to do next

See [Chapter 2, “Installing the Tivoli Storage Manager server components,” on page|
for installation steps to reinstall the Tivoli Storage Manager components.

Uninstalling Tivoli Storage Manager by using a graphical wizard

You can uninstall Tivoli Storage Manager by using the IBM Installation Manager
installation wizard.

Procedure

1.

S < A

Start the Installation Manager.

In the directory where the Installation Manager is installed, go to the eclipse
subdirectory (for example, /opt/IBM/InstallationManager/eclipse), and issue
the following command:

./IBMIM

Click Uninstall.

Select IBM Tivoli Storage Manager server, and click Next.
Click Uninstall.

Click Finish.
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Uninstalling Tivoli Storage Manager in console mode

To uninstall Tivoli Storage Manager by using the command line, you must run the
uninstallation program of IBM Installation Manager from the command line with
the parameter for console mode.

Procedure

1. In the directory where IBM Installation Manager is installed, go to the
following subdirectory:

eclipse/tools
For example:
/opt/IBM/InstallationManager/eclipse/tools
2. From the tools directory, issue the following command:
./imcl -c
To uninstall, enter 5.
Choose to uninstall from the IBM Tivoli Storage Manager package group.
Enter N for Next.
Choose to uninstall the IBM Tivoli Storage Manager server package.
Enter N for Next.
Enter U for Uninstall.
Enter F for Finish.
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To uninstall Tivoli Storage Manager in silent mode, you must run the
uninstallation program of IBM Installation Manager from the command line with
the parameters for silent mode.

Before you begin

The input directory, which is in the directory where the installation package is
extracted, contains the following sample response files for installing, updating, and
uninstalling the server:

* install_response_sample.xml
* update_response_sample.xm]
* uninstall_response sample.xml

You can use these sample files as they are with the default values, or you can
customize them to suit your needs.

Procedure

1. In the directory where IBM Installation Manager is installed, go to the
following subdirectory:

eclipse/tools
For example:
/opt/IBM/InstallationManager/eclipse/tools

2. From the tools directory, issue the following command, where response_file
represents the response file path, including the file name:

./imc1 -input response_file -silent
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The following command is an example:

./imc1 -input /tmp/input/uninstall_response.xml -silent

Uninstalling and reinstalling Tivoli Storage Manager

If you plan to manually reinstall Tivoli Storage Manager instead of using the
wizard, there are a number of steps to take to preserve your server instance names
and database directories. During an uninstallation, any server instances previously
set up are removed, but the database catalogs for those instances still exist.

About this task

If you are using the wizard to upgrade from Tivoli Storage Manager Version 6.2 or
Version 6.3, it is not necessary to complete these steps, the wizard completes them

automatically. To manually uninstall and reinstall Tivoli Storage Manager, complete
the following steps:

1.

Make a list of your current server instances before proceeding to the
uninstallation. Run the following command:

/opt/tivoli/tsm/db2/instance/db2ilist
Run the following commands for every server instance:

db2 attach to instance_name
db2 get dbm cfg show detail
db2 detach

Keep a record of the database path for each instance.

Uninstall Tivoli Storage Manager. See [Chapter 8, “Uninstalling Tivoli Storage]
[Manager,” on page 85

When you uninstall any version of Tivoli Storage Manager 6.1 or later,
including a fix pack, an instance file is created. The instance file is created to
help reinstall Tivoli Storage Manager. Check this file and use the information
when you are prompted for the instance credentials when reinstalling. In silent
installation mode, you provide these credentials using the INSTANCE_CRED
variable.

You can find the instance file in the following location:
/etc/tivoli/tsm/instancelList.obj

Reinstall Tivoli Storage Manager. See [Chapter 2, “Installing the Tivoli Storage]
[Manager server components,” on page 31

Recreate your server instances. See [“Creating the server instance” on page 44,

Tip: The installation wizard configures the server instances but you must
verify that they exist. If they do not exist, you must manually configure them.
Catalog the database. Log in to each server instance as the instance user, one at
a time, and issue the following commands:

db2 catalog database tsmdbl

db2 attach to instance_name

db2 update dbm cfg using dftdbpath instance_directory
db2 detach

Verify that the server instance was created successfully. Issue this command:
/opt/tivoli/tsm/db2/instance/db2ilist
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9. Verify that Tivoli Storage Manager recognizes the server instance by listing
your directories. Your home directory appears if you did not change it. Your
instance directory does appear if you used the configuration wizard. Issue this
command:

db2 Tist database directory

If you see TSMDBI listed, you can start the server.
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Part 2. Installing and upgrading Tivoli Monitoring for Tivoli
Storage Manager

IBM Tivoli Monitoring for Tivoli Storage Manager is not delivered with Tivoli
Storage Manager V7.1.

About this task

You can use Tivoli Monitoring for Tivoli Storage Manager Version 6.3.4 with any
Tivoli Storage Manager Version 5.5 or later server. For more information about
installing and configuring Tivoli Monitoring for Tivoli Storage Manager, see
Technote 1649883 at: |http:/ /www.ibm.com /support /|
[docview.wss?uid=swg21649883]
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Appendix A. Installation log files

If you experience errors during installation, these errors are recorded in log files
that are stored in the IBM Installation Manager logs directory.

You can view installation log files by clicking File > View Log from the Installation

Manager tool. To collect these log files, click Help > Export Data for Problem
Analysis from the Installation Manager tool.
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Appendix B. Tivoli support information

You can find support information for Tivoli and other IBM products from various
sources.

From the IBM Support Portal at http:/ /www.ibm.com/support/entry /portal /] you
can select the products that you are interested in and search for a wide variety of
relevant information.

Communities and other learning resources

In addition to product documentation, many forms of assistance are available to
help you get started as you deploy and use the Tivoli Storage Manager family of
products. These resources can also help you to solve problems that you might
have.

You can use forums, wikis, and other social media tools to ask questions, talk to
experts, and learn from others.

User groups

Tivoli Global Storage Virtual User Group
Access this user group at [http: / /www.tivoli-ug.org /storage}

This group makes it possible for individuals from many different industries
and types of organizations to share information and work directly with the
IBM product experts. Local chapters also exist where members meet in
person to share experiences and hear from guest speakers.

ADSM.ORG
Access this mailing list at |http://adsm.org|

This independently managed Storage Management discussion forum
started when Tivoli Storage Manager was known as ADSTAR Distributed
Storage Manager (ADSM). The members of this forum have many years of
experience with Tivoli Storage Manager in almost every type of IT
environment.

To subscribe to the forum, send an email to listserv@vm.marist.edu. The
body of the message must contain the following text: SUBSCRIBE ADSM-L
your_first_name your_family_name.

Tivoli Storage Manager community on Service Management
Connect

Access Service Management Connect at Ihttp:/ /www.ibm.com/ developerworks/ |
kervicemanagement In the [Storage Management community| of Service
Management Connect, you can connect with IBM in the following ways:

* Become involved with transparent development, an ongoing, open engagement
between users and IBM developers of Tivoli products. You can access early
designs, sprint demonstrations, product roadmaps, and prerelease code.

¢ Connect one-on-one with the experts to collaborate and network about Tivoli
and the Tivoli Storage Manager community.

* Read blogs to benefit from the expertise and experience of others.
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* Use wikis and forums to collaborate with the broader user community.

Tivoli Storage Manager wiki on developerWorks®

Access this wiki at |https://www.ibm.com/developerworks/servicemanagement /|

Igm / index.htmll

Find the latest best practices, white papers, and links to videos and other
resources. When you log on, you can comment on content, or contribute your own
content.

Tivoli Support Technical Exchange

Find information about upcoming Tivoli Support Technical Exchange webcasts at
lhttp:/ /www.ibm.com /software/sysmgmt/products/support/supp_tech_exch.html|
Replays of previous webcasts are also available.

Learn from technical experts who share their knowledge and then answer your
questions. The sessions are designed to address specific technical issues and
provide in-depth but narrowly focused training.

Other social media sites

LinkedIn
You can join groups on LinkedIn, a social media site for professionals. For
example:

+ Tivoli Storage Manager Professionals: [http:/ /www.linkedin.com /|
[eroups/ Tivoli-Storage-Manager-Professionals-54572)

+ TSM: http:/ /www.linkedin.com/ groups?gid=64540|

Twitter
Follow @IBMStorage on Twitter to see the latest news about storage and
storage software from IBM.

Tivoli education resources

Use these education resources to help you increase your Tivoli Storage Manager
skills:

Tivoli Education and Certification website
View available education at |http:/ /www.ibm.com/software/tivoli /|

Use the Search for Training link to find local and online offerings of
instructor-led courses for Tivoli Storage Manager.

Education Assistant
Access resources at |http: / /publib.boulder.ibm.com/infocenter/ieduasst/| |
tivv1r0/index.jspl

Scroll to view the list of available training videos. Recorded product
demonstrations are also available on a YouTube channel.
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Searching knowledge bases

If a problem occurs while you are using one of the Tivoli Storage Manager family
of products, you can search several knowledge bases.

Begin by searching the Tivoli Storage Manager Information Center at

|http: / /pic.dhe.ibm.com /infocenter/tsminfo/ V7rll Within the information center,
you can enter words, phrases, or message numbers in the Search field to find
relevant topics.

Searching the Internet

Using

If you cannot find an answer to your question in the Tivoli Storage Manager
information center, search the Internet for the information that might help you
resolve the problem.

To search multiple Internet resources, go to the IBM support website at
http:/ /www.ibm.com /support/entry /portal /| You can search for information
without signing in.

Sign in using your IBM ID and password if you want to customize the site based

on your product usage and information needs. If you do not already have an IBM
ID and password, click Sign in at the top of the page and follow the instructions

to register.

From the support website, you can search various resources:
* IBM technotes.

* IBM downloads.

« IBM Redbooks® publications.

e IBM Authorized Program Analysis Reports (APARs). Select the product and click
Downloads to search the APAR list.

IBM Support Assistant

IBM Support Assistant is a complimentary software product that can help you with
problem determination. It is available for some Tivoli Storage Manager and Tivoli
Storage FlashCopy® Manager products.

IBM Support Assistant helps you gather support information when you must open
a problem management record (PMR), which you can then use to track the
problem. The product-specific plug-in modules provide you with the following
resources:

¢ Support links
* Education links
* Ability to submit problem management reports

You can find more information and download the IBM Support Assistant web page
at|http:/ /www.ibm.com /software /support /isal

You can also install the stand-alone IBM Support Assistant application on any
workstation. You can then enhance the application by installing product-specific
plug-in modules for the IBM products that you use. Find add-ons for specific
products at fhttp: / /www.ibm.com/support/docview.wss?uid=swg27012689}
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Finding product fixes

A product fix to resolve a software problem might be available from the IBM
software support website.

Procedure

Determine what fixes are available by checking the IBM software support website
at|http:/ /www.ibm.com /support/entry /portal /}

If you previously customized the site based on your product usage:

1. Click the link for the product, or a component for which you want to
find a fix.

2. Click Downloads, and then click Search for recommended fixes.

If you have not previously customized the site:
Click Downloads and search for the product.

Receiving notification of product fixes

You can receive notifications about fixes, flashes, upgrades, and other news about
IBM products.

Procedure

1. From the support page at [http: / /www.ibm.com /support/entry/portal /} click
Sign in and sign in using your IBM ID and password. If you do not have an
ID and password, click register now and complete the registration process.

2. Click Manage all my subscriptions in the Notifications pane.
3. Click the Subscribe tab, and then click Tivoli.

4. Select the products for which you want to receive notifications and click
Continue.

5. Specify your notification preferences and click Submit.

Contacting IBM Software Support

You can contact IBM Software Support if you have an active IBM subscription and
support contract, and if you are authorized to submit problems to IBM.

Procedure
1. Ensure that you have completed the following prerequisites:

a. [Set up a subscription and support contract

b. [Determine the business impact of the problem|

c. [Describe the problem and gather background information)

2. Follow the instructions in [“Submitting the problem to IBM Software Support”|
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Setting up and managing support contracts
You can set up and manage your Tivoli support contracts by enrolling in IBM
Passport Advantage. The type of support contract that you need depends on the
type of product you have.
Procedure

Enroll in IBM Passport Advantage in one of the following ways:

» Online: Go to the Passport Advantage website at |ttp://www.ibm.com /|
[software/lotus/passportadvantage/} click How to enroll, and follow the
instructions.

* By telephone: For critical, system-down, or high-severity issues, you can call
1-800-IBMSERYV (1-800-426-7378) in the United States. For the telephone number
to call in your country, go to the IBM Software Support Handbook web page at
|http: / /wwwl4.software.ibm.com/webapp/set2/sas/f/handbook/ home.htm]|
and click Contacts.

Determining the business impact

When you report a problem to IBM, you are asked to supply a severity level.
Therefore, you must understand and assess the business impact of the problem
you are reporting.

Severity level Description

Severity 1 Critical business impact: You are unable to use the program,
resulting in a critical impact on operations. This condition
requires an immediate solution.

Severity 2 Significant business impact: The program is usable but is
severely limited.

Severity 3 Some business impact: The program is usable with less
significant features (not critical to operations) unavailable.

Severity 4 Minimal business impact: The problem causes little impact on
operations, or a reasonable circumvention to the problem has
been implemented.

Describing the problem and gathering background information

When explaining a problem to IBM, it is helpful to be as specific as possible.
Include all relevant background information so that IBM Software Support
specialists can help you solve the problem efficiently.

To save time, know the answers to these questions:
* What software versions were you running when the problem occurred?

* Do you have logs, traces, and messages that are related to the problem
symptoms? IBM Software Support is likely to ask for this information.

¢ Can the problem be re-created? If so, what steps led to the failure?

* Have any changes been made to the system? For example, hardware, operating
system, networking software, and so on.

* Are you using a workaround for this problem? If so, be prepared to explain it
when you report the problem.
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Submitting the problem to IBM Software Support

You can submit the problem to IBM Software Support online or by telephone.

Online

Go to the IBM Software Support website at |http:/ /www.ibm.com /|
support/entry/portal/Open_service_request/Software/ |
Software_support_(general)| Sign in to access IBM Service Requests and
enter your information into the problem submission tool.

By telephone
For critical, system-down, or severity 1 issues, you can call 1-800-IBMSERV
(1-800-426-7378) in the United States. For the telephone number to call in
yvour country, o to the IBM Software Support Handbook web page at
http:/ /www14.software.ibm.com /webapp /set2 /sas/f/handbook /|
home.html|and click Contacts.
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Appendix C. Accessibility features for the Tivoli Storage
Manager product family

Accessibility features help users who have a disability, such as restricted mobility
or limited vision to use information technology products successfully.

Accessibility features

The IBM Tivoli Storage Manager family of products includes the following
accessibility features:

* Keyboard-only operation using standard operating-system conventions
¢ Interfaces that support assistive technology such as screen readers

The command-line interfaces of all products in the product family are accessible.

Tivoli Storage Manager Operations Center provides the following additional
accessibility features when you use it with a Mozilla Firefox browser on a
Microsoft Windows system:

* Screen magnifiers and content zooming
* High contrast mode

The Operations Center and the Tivoli Storage Manager Server can be installed in
console mode, which is accessible.

The Tivoli Storage Manager Information Center is enabled for accessibility. For
information center accessibility information, see “Accessibility features in the
information center” ( |http://pic.dhe.ibm.com/infocenter /tsminfo/v7rl/topic/|
fcom.ibm.help.ic.doc/iehs36_accessibility.html).

Vendor software

The Tivoli Storage Manager product family includes certain vendor software that is
not covered under the IBM license agreement. IBM makes no representation about
the accessibility features of these products. Contact the vendor for the accessibility
information about its products.

IBM and accessibility

See the [I[BM Human Ability and Accessibility Center| (http:/ /www.ibm.com /abld)
for information about the commitment that IBM has to accessibility.
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte character set (DBCS) information,
contact the IBM Intellectual Property Department in your country or send
inquiries, in writing, to:

Intellectual Property Licensing

Legal and Intellectual Property Law
IBM Japan, Ltd.

19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM websites are provided for
convenience only and do not in any manner serve as an endorsement of those
websites. The materials at those websites are not part of the materials for this IBM
product and use of those websites is at your own risk.
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IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who want to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation
274A/101

11400 Burnet Road
Austin, TX 78758
U.S.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this information and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement, or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

This information is for planning purposes only. The information herein is subject to
change before the products described become available.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. The sample
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programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.

Each copy or any portion of these sample programs or any derivative work, must
include a copyright notice as follows: © (your company name) (year). Portions of
this code are derived from IBM Corp. Sample Programs. © Copyright IBM Corp.

_enter the year or years_.

If you are viewing this information in softcopy, the photographs and color
illustrations may not appear.

Trademarks

IBM, the IBM logo, and ibm.com® are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the Web at "Copyright and
trademark information" at|http://www.ibm.com/legal/copytrade.shtm]

Linux is a registered trademark of Linus Torvalds in the United States, other
countries, or both.

Microsoft and Windows are trademarks of Microsoft Corporation in the United
States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

p— J Java and all Java-based trademarks and logos are trademarks or registered
— trademarks of Oracle and/or its affiliates.
COMPATIBLE

Privacy policy considerations

IBM Software products, including software as a service solutions, (“Software
Offerings”) may use cookies or other technologies to collect product usage
information, to help improve the end user experience, to tailor interactions with
the end user or for other purposes. In many cases no personally identifiable
information is collected by the Software Offerings. Some of our Software Offerings
can help enable you to collect personally identifiable information. If this Software
Offering uses cookies to collect personally identifiable information, specific
information about this offering’s use of cookies is set forth below.

This Software Offering does not use cookies or other technologies to collect
personally identifiable information.

If the configurations deployed for this Software Offering provide you as customer
the ability to collect personally identifiable information from end users via cookies
and other technologies, you should seek your own legal advice about any laws
applicable to such data collection, including any requirements for notice and
consent.
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For more information about the use of various technologies, including cookies, for
these purposes, see IBM’s Privacy Policy at |http://www.ibm.com/privacy|and
IBM’s Online Privacy Statement at |http:/ /www.ibm.com/privacy/details|the
section entitled “Cookies, Web Beacons and Other Technologies” and the “IBM
Software Products and Software-as-a-Service Privacy Statement” at

lhttp:/ /www.ibm.com /software /info/product-privacyl
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Glossary

A glossary is available with terms and definitions for the IBM Tivoli Storage Manager family of products.

You can view the glossary in the Tivoli Storage Manager information center at fnttp:/ /pic.dhe.ibm.com/|
linfocenter / tsminfo /v7r1

To view glossaries for other IBM products, see |nttp://www.ibm.com /software/globalization /|
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